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END-USER LICENSE AGREEMENT
WITH METTLER TOLEDO

FOR
WinBridge ® Software

This END-USER LICENSE AGREEMENT FOR WinBridge ® SOFTWARE (hereinafter
“AGREEMENT”) is entered into by and between the END-USER LICENSEE and Mettler-
Toledo, Inc., a Delaware corporation with a principal place of business at 1900 Polaris
Parkway, Columbus, Ohio 43240 (hereinafter “MTI”). In return for good and valuable
consideration, the receipt and sufficiency of which are hereby acknowledge, END-USER
LICENSEE and MTI agree as follows:

1. Definitions

a.  “SOFTWARE” shall mean the WinBridge ® Software, documentation, manuals
and other materials as packaged and/or delivered by MTI to END-USER
LICENSEE, including without limitation, any and all updates, later versions or
revisions, upgrades, improvements, enhancements or modifications made
during the term hereof. SOFTWARE shall include, but not be limited to, any
changes, updates, later versions, revisions, upgrades, improvements,
enhancements or modifications made thereto by MTI by virtue of MTI’s activity as
a CONFIGURATOR, including those made specifically at the request or direction of
END-USER LICENSEE.

b.  “SITE” shall refer only to the address identified above for END-USER
LICENSEE.

c.  “CONFIGURATION TOOLS” shall mean all software and all information,
whether in electronic, written or verbal form, used by MTI to customize the
SOFTWARE to meet the needs of END-USER LICENSEE. CONFIGURATION TOOLS
shall include but not be limited to the Configurator Software program, WinEdit
Tools, and Report Writer Tools, marketing materials, flow charts, pricing
information, and demo programs as well as any and all updates, later versions
or revisions, upgrades, improvements, enhancements or modifications thereto.
CONFIGURATION TOOLS shall not include any information disclosed by END-
USER LICENSEE for the purpose of enabling MTI to customize the SOFTWARE to
meet the needs of END-USER LICENSEE.

d.  “CONFIGURATOR” shall refer to the activity of MTI in marketing, installing,
and/or customizing the SOFTWARE to meet the needs of END-USER LICENSEE.

e.  "LICENSED CPU" shall mean any single central processing unit owned or
leased by END-USER Licensee and located at the SITE. If “LAN OPTION” is
selected, then LICENSED CPU shall mean the computer system comprising a file
server and up to five (5) concurrent users.



2. GRANT OF LICENSE

a.  Effective upon logging into SOFTWARE, MTI hereby grants to END-USER
LICENSEE, and END-USER LICENSEE hereby accepts, a personal, nonexclusive
and nontransferable license to utilize only at the SITE and only upon the
LICENSED CPU, during the term hereof, the SOFTWARE, subject to the conditions
set forth herein (hereinafter “SOFTWARE LICENSE”). A separate license shall be
required, together with the payment of additional license fees, to concurrently
use the SOFTWARE on anything other than the LICENSED CPU at the SITE. END-
USER LICENSEE acquires no rights in or to the CONFIGURATION TOOLS.

3. LICENSE RESTRICTIONS

a.  END-USER LICENSEE agrees:

1.  not to market, distribute or disclose to any third party the SOFTWARE, or any
portion thereof; and

2.  not to reverse engineer, decompile, reproduce or modify the SOFTWARE or
any portion thereof without MTI's prior written consent; END-USER LICENSEE
may make one (1) copy of the floppy disks provided with the SOFTWARE: (i) for
archival purposes or, (ii) when copying is an essential step in the use of the
SOFTWARE with the LICENSED CPU so long as the copies are used in no other
manner; if the LICENSED CPU is inoperative due to malfunction, the license granted
under this AGREEMENT shall be temporarily extended to authorize the END-USER
LICENSEE to use the SOFTWARE on another computer at the SITE until the
LICENSED CPU is returned to operation; END-USER LICENSEE may not copy any
of the documentation or written materials which are part of the SOFTWARE; and

3.  not to remove any labeling or notices included with or embedded in the
SOFTWARE; and

4.  to promptly inform MTI of any unauthorized possession, use or copying by
END-USER LICENSEE or others of the SOFTWARE or any portion thereof; and

4. OWNERSHIP

a.  Title.  Title to the SOFTWARE is not transferred to END-USER LICENSEE.
Ownership of the SOFTWARE and of authorized copies made by END-USER
LICENSEE is vested in MTI, subject to the rights granted to END-USER LICENSEE
in this AGREEMENT. END-USER LICENSEE agrees that the SOFTWARE is the
exclusive property and constitutes a valuable trade secret of MTI. END-USER
LICENSEE shall not disclose or make available the SOFTWARE, or any portion
thereof, to third parties without MTI's prior written consent.

5. SUPPORT - END-USER LICENSEE shall identify to MTI one member of its staff having
sufficient expertise in the SOFTWARE (“LIAISON CONTACT”) to act as the primary technical
liaison responsible for all communications with MTI regarding the SOFTWARE. The
LIAISON CONTACT shall direct all communications regarding the SOFTWARE to MTI.



6.  A. LIMITED WARRANTIES - MTI EXPRESSLY WARRANTS THE SOFTWARE PROVIDED TO
END-USER LICENSEE AS SET FORTH HEREIN.  MTI MAKES NO OTHER WARRANTIES, EITHER
EXPRESS OR IMPLIED (INCLUDING WITHOUT LIMITATION WARRANTIES AS TO
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE).  In addition, the following
shall constitute the sole and exclusive remedies of END-USER LICENSEE for any breach by
MTI of its warranty hereunder.

MTI warrants that the media upon which the SOFTWARE are provided to END-USER
LICENSEE will be free from defects in workmanship and materials for a period of one (1)
year from the date of shipment to the END-USER LICENSEE.  Should any such defects be
found and reported during such one year period MTI will send END-USER LICENSEE
replacement media.

MTI does not warrant that any software comprising the SOFTWARE will be free from errors
in program logic, clerical program preparation and transcription. The foregoing warranty
shall not apply to defects resulting from: (1) unauthorized modification; (2) END-USER
supplied software or interfacing; (3) accident, transportation, neglect, misuse, alteration,
modification, or enhancement by anyone other than MTI; (4) the failure to provide a
suitable installation environment; (5) uses other than the specific purpose for which the
Software is designed; (6) use on any systems other than specified MTI hardware; or (7)
failure to incorporate any update(s) previously released by MTI.

B. DISCLAIMER - EXCEPT AS EXPRESSLY STATED HEREIN, THE SOFTWARE IS PROVIDED
"AS IS" WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, WARRANTIES OF PERFORMANCE OR MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE.  END-USER LICENSEE BEARS ALL RISK RELATING TO QUALITY
AND PERFORMANCE OF THE SOFTWARE.  MTI does not warrant the level of performance
of the SOFTWARE, nor does MTI warrant that the SOFTWARE will meet END-USER
LICENSEE’s requirements nor that the SOFTWARE will operate without interruption or be
error free. LICENSEE SHALL BE SOLELY RESPONSIBLE FOR THE SELECTION,
INSTALLATION, USE, EFFICIENCY AND SUITABILITY OF THE SOFTWARE AND/OR ANY
CUSTOMIZATION OF SAME AND MTI SHALL HAVE NO LIABILITY THEREFOR. IN NO EVENT
SHALL MTI BE LIABLE TO END-USER LICENSEE FOR ANY DAMAGES RESULTING FROM OR
RELATED TO ANY FAILURE OF THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO LOSS
OF DATA, OR DELAY BY MTI IN THE DELIVERY OF THE SOFTWARE. EXCEPT TO THE EXTENT
PROVIDED IN SECTION 6.D. “INDEMNIFICATION BY MTI”, IN NO EVENT AND UNDER NO
CIRCUMSTANCES SHALL MTI BE LIABLE FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL,
OR PUNITIVE DAMAGES, OR FOR ANY LOST PROFITS OR FOR ANY OTHER TYPE OF DAMAGE,
INCLUDING BUT NOT LIMITED TO ANY DAMAGES RESULTING FROM OR RELATED TO ANY
FAILURE OF THE SOFTWARE and/or CONFIGURATION TOOLS, LOSS OF DATA, OR DELAY
by MTI IN THE DELIVERY OF THE SOFTWARE AND/OR CONFIGURATION TOOLS OR IN THE
PERFORMANCE OF THIS AGREEMENT, EVEN IF MTI HAS BEEN ADVISED OF THE
POSSIBILITY THEREOF. MTI’s LIABILITY HEREUNDER TO END-USER LICENSEE, IF ANY,
SHALL IN NO EVENT EXCEED ONE THOUSAND DOLLARS. No action, regardless of form,
arising out of the transactions under this AGREEMENT may be brought by either party more
than one (1) year after the cause of action has accrued.

C.  Limitation of Liability - END-USER LICENSEE's exclusive remedy for breach by MTI of
the above limited warranty shall be replacement of any defective medium returned to MTI
within the warranty period. END-USER LICENSEE agrees not to hold MTI responsible for
any losses or damages arising out of any acts or omissions of MTI related to the
provision of the SOFTWARE to END-USER LICENSEE, including but not limited to MTI’s



activities as a CONFIGURATOR. END-USER LICENSEE acknowledges that it must enter into
a separate written agreement with MTI to specify how the SOFTWARE is to be customized
to meet the needs of END-USER LICENSEE and the amount of license fee to be paid for the
SOFTWARE.  IN NO EVENT shall such other written agreement between END-USER
LICENSEE and MTI alter or change any of the terms and conditions contained in this
AGREEMENT.

D. INDEMNIFICATION BY MTI - MTI shall defend any suit or proceeding brought against
END-USER LICENSEE so far as the same is based on a claim that the SOFTWARE furnished
by MTI hereunder, or any part thereof, constitutes an infringement of any United States
patent or United States copyright, if notified promptly in writing and given authority
information and assistance (at MTI’s expense) for the defense of the same and if such
alleged infringement is not the result of a design or other special requirement specified by
END-USER LICENSEE such as, but not limited to, how the SOFTWARE has been customized
for END-USER LICENSEE.  MTI will pay all damages and costs awarded in such suit or
proceeding provided that MTI shall have the sole and exclusive right to defend, settle or
compromise any suit or proceeding and END-USER takes no action which would materially
detract from MTI's ability to conduct an effective defense, settlement or compromise.  In
case any portion of the SOFTWARE in such suit is held to infringe any such patent or
copyright and the use thereof is enjoined, MTI shall at its expense and at its sole option,
either: (a) obtain for END-USER LICENSEE the right to continue using such SOFTWARE or
part thereof or; (b) replace the same with non infringing material, or; (c) modify the same
so that it becomes non infringing or; (d) accept return of the SOFTWARE and pay END-
USER LICENSEE one-thousand dollars ($1,000.00).  The foregoing states the entire liability
of MTI to END-USER LICENSEE for patent and/or copyright infringement. MTI shall have no
liability for any claim of copyright or patent infringement based on (a) uses of other than the
latest unmodified release of the SOFTWARE if such infringement could have been avoided by
the use of the latest release.

7. Term and Termination - The term of this AGREEMENT and of the license granted herein
shall commence on the date this AGREEMENT is signed by END-USER LICENSEE and
shall continue until END-USER LICENSEE discontinues the licensed use of the SOFTWARE
on the LICENSED CPU.  END-USER LICENSEE may terminate this AGREEMENT by giving
MTI written notice of termination.  MTI may terminate this AGREEMENT by giving END-
USER LICENSEE written notice of termination if END-USER LICENSEE commits a material
breach hereof or if END-USER LICENSEE becomes insolvent or seeks protection,
voluntarily or involuntarily, under any bankruptcy law.  Upon any termination of this
AGREEMENT, END-USER LICENSEE shall cease all use of SOFTWARE, destroy all copies
then in its possession and take such other actions as MTI may reasonably request to
ensure that no copy of SOFTWARE remains in END-USER LICENSEE's possession.

8. Effect of Agreement - This Agreement is the sole agreement between the parties relating
to the subject matter hereof and supersedes all prior understandings, writings, proposals,
representations or communications, oral or written, of either party. No provision hereof may
be waived, modified or superseded, except by written document signed by the parties hereto.
If any provision herein is deemed to be unenforceable or illegal, the parties shall negotiate
in good faith to achieve a new legal enforceable provision which most closely
approximates the original intent of the provision declared unenforceable or illegal. Any
cause of action arising out of or related to this AGREEMENT must be brought no later than
one year after it has accrued. Excepting defined terms which are denoted with capital
letters, the headings and captions contained in this AGREEMENT are inserted for



convenience only and shall not constitute a part hereof. This Agreement may be executed
in several counterparts, each of which shall be deemed an original and all of which shall
constitute one and the same instrument.

9. Governing Law - This AGREEMENT shall be governed by and construed under the laws
of the State of Ohio, U.S.A.

10. Assignment - Neither this AGREEMENT nor any part or portion hereof shall be
assigned, sublicensed or otherwise transferred by END-USER LICENSEE. Failure of a party
to enforce any provision of this AGREEMENT shall not constitute or be construed as a
waiver of such provision or of the right to enforce such provision.  MTI may assign any
part or portion of this AGREEMENT to an authorized MTI distributor.

11. U.S. GOVERNMENT RESTRICTED RIGHTS - The SOFTWARE is provided with
RESTRICTED RIGHTS.  Use, duplication or disclosure by the government is subject to
restrictions as set forth in subparagraph (c)(I )(ii) of the Rights in Technical Data in
Computer Software clause at DFARS 252.227-7013 or the Commercial Computer
Software Restricted Rights clause at FAR 52.227-19 subdivision (c)(1) and (2), as
applicable.  Contractor/manufacturer is Mettler-Toledo, Inc., 1900 Polaris Parkway,
Columbus, Ohio 43240.
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1 Introduction

Purpose
The WinBridge® Vehicle Scale Information Technology software
package is designed to handle transactions in which material is
bought, sold, or processed on a scale. WinBridge software can
connect to as many as four scale indicators, plus peripherals such
as bar-code readers, traffic lights, and unattended driver stations.
This manual explains how to use WinBridge software.

The main purposes of the WinBridge software package:

•  Record transactions that involve weighing vehicles.

•  Produce reports about the transactions.

•  Provide information from the WinBridge database in ASCII file
format use with external software packages.

•  Manage unattended weighing stations.

Requirements
WinBridge 1.3.9 requires the following minimum hardware:

•  A personal computer with

 Pentium®/133 MHz CPU

 CD-ROM player

 32 MB RAM

 1 GB hard drive

 800x600 SVGA monitor using small fonts. Monitor
should be 17 inches or larger to make it easy to read the
screen, especially if you include the maximum options.

 Parallel printer for reports and tickets

•  An 8530 Cougar, 8142, Jaguar, Lynx, Panther, or
compatible Cardinal, Fairbanks, GSE, Rice Lake, Western, or
Weigh-Tronix scale indicator.

•  Optional: An Unattended Terminal (contact your METTLER
TOLEDO distributor for hardware and software specifications).

The following minimum software is required:

•  Windows 95, 98, or NT
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Overview
The following list outlines the basic steps involved in setting up
and operating your WinBridge system:

1. Have your supplier install WinBridge and configure it for you.
Discuss your processing needs with the supplier to make sure
the installation is configured to meet them. Your supplier can
handle the following configuration options:

•  Install on a single PC or network

•  Install add-ons such as unattended terminals

•  Connect to scales and traffic lights

•  Translate the program to another language

•  Change the appearance of screens

•  Enable/disable individual functions

•  Enable supervisors and operators

•  Set up tickets and reports for printing

•  Provide WinBridge passwords

2. Create database records (see Chapters 3, 4 and 5). Before
you can process transactions, you need to enter information
about products, accounts, contracts, vehicles, etc., in your
database.

3. Process transactions (see Chapter 6). Once you have had
your WinBridge system configured and have entered
information in the database, you can begin processing
transactions. You can speed up transactions by creating
presets that automatically enter data for a transaction.

4. Print tickets and reports (see Chapter 6). WinBridge can print
a ticket automatically for each transaction. It also provides a
selection of basic reports that you can print. The optional
report module enables you to design your own tickets and
reports.

5. Manage records of transactions (see Chapter 6). WinBridge
stores a complete record of each transaction. It gives you the
ability to void, modify, and export transactions.

6. Manage the database (see Chapter 6). WinBridge enables
you to backup your database, import information into the
database, and export information from the database for use
with other software packages.

7. Change default settings (see Chapter 7). You can change a
wide range of default settings to modify the way your
WinBridge system operates.
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How to Start
WinBridge

Your supplier will install the WinBridge program and configure it for
you. Each time you start WinBridge, you must identify yourself as
an authorized user.

 
1. Start SQLBase by selecting the SQLBase Database Engine

icon and double-clicking on it (or pressing the ENTER key).

2. Select the WB icon and double-click on it (or press the
ENTER key). The WinBridge Log In screen will appear.

 

3. Place the cursor in the Operator field and type your user
name.

4. Move the cursor to the Password field and type your
password. The password will not be shown in the field;
each character will appear as an asterisk.

5. Click the Login button or press the ENTER key to start
WinBridge (click the Logout button to exit).

If you typed your user name and password correctly, the WinBridge
Vehicle Processing screen will appear.
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How to Close
WinBridge

To close WinBridge, click the Close button on the Vehicle
Processing screen (or select Exit from the Program menu). Type
your user name and password in the data fields on the WinBridge
Log In screen. Then click the Logout button to exit.

If you have started WinBridge but have not entered a user name or
password, you can exit the program by pressing the ESC key or
clicking the Logout button.

How to Select
a Menu Item

1. If you have a mouse, click on the menu item.

2. If you do not have a mouse, press the ALT key to select the
first menu item, and then use the left and right arrow keys to
move to other menu items.

•  To open a menu, use the down arrow key.

•  To select a menu item, highlight it with the up or down
arrow key and then press the ENTER key.

How to Press
a Push Button

1. If you have a mouse, click on the push button.

2. If you do not have a mouse, press ALT+ the character that is
underlined on the push button.

How to Use
Data Fields

To move from an input data field to the next field, press the TAB
key. This also checks any data entered in the field to make sure it
is valid. To move to the previous data field, press TAB+SHIFT.

WinBridge can be configured so that the ENTER key (instead of the
TAB key) is used to move from one field to another. When the
ENTER key is used to move between fields, it cannot be used for
other purposes, such as accepting a weight.
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2 Vehicle Processing Screen

When you start the WinBridge program, the Vehicle Processing
screen will appear. This screen is used to process all vehicle
weighing transactions. It also provides access to WinBridge tables,
reports, and other tools. The exact appearance and operation of the
Vehicle Processing screen depends on how WinBridge is
configured by your supplier. The sample screen shown below
offers the most complete set of vehicle processing options. In other
configurations, some fields and buttons might be arranged
differently or hidden. The order in which fields are entered on the
screen also depends on how your system is configured.



METTLER TOLEDO WinBridge Software User Manual

       (9/00)2-2

Menu Bar
The menu bar shows the main functions available in WinBridge:
Program, Edit, Table, Extended Tables, Report/Ticket, Database,
Scale, Tools, and Help. Clicking on one of these will display a
secondary menu (for example, clicking on Table displays the list of
tables available for editing).

The Program menu is used to exit WinBridge. The Edit menu
provides Undo, Cut, Copy, Paste, and Clear commands for editing
data field entries. Tables are discussed in Chapter 3, Extended
Tables in Chapter 4, and other menu items in Chapters 6 and 7.

Toolbar
The toolbar is located under the menu bar. The push buttons and
data fields found on the toolbar are described below.

Close: Exits from the Vehicle Processing screen (same as Exit in
the Program menu).

Search: Displays the table associated with the data field in which
the cursor is positioned. When you select a record from the table
(by pressing ENTER or double-clicking the left mouse button),
information from the record is entered into the data field. You can
also display a table by clicking the right mouse button on the
appropriate data field. If a partial ID is specified in a field, the table
will open on the first row that includes that partial ID.

One/Two: Toggles between one-pass weighing (weigh a loaded
vehicle and use a stored tare weight or manual tare entry) and
two-pass weighing (weigh a vehicle once when it is empty and
once when it is loaded). Two-pass weighing is the default for
vehicles without a stored tare weight.

Split: Allows split-load transactions (weights are recorded twice,
possibly under different product codes). THIS PROCESS IS NOT
WEIGHTS AND MEASURES APPROVED.

Contract: Enables/disables the use of the contract functions for the
current transaction.

Transaction: Displays a table that lists all two-pass transactions
that are open (have not been completed). When a vehicle returns
for its second weighing, select the appropriate open transaction to
complete the two-pass weighing operation.
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Preset: Loads preset default values into empty data fields (see the
information about using presets in Chapter 6).

Report: Allows you to choose, print, or view reports.

Ticket: Prints a ticket for the most recent transaction.

Unattended: Switches between operator and unattended mode.

Calculator: Displays a calculator for the operator to use.

Help: Displays the on-line help (same as Help menu).

Store Tare: Allows you to store a tare for a vehicle. It is enabled
only when a vehicle is specified in the Vehicle field and has been
verified in the database.

Transaction Number: Shows the current transaction number. You
must export all data before you reset this number.

Scale 1,2,3,4: Reads the weight from any of the enabled scale
devices.

Virtual Indicator: Retrieves a weight from a virtual indicator.

Manual: Allows manual input of weight. This is available only if the
operator is authorized and manual mode is enabled for the product.

Use Stored Tare: Automatically inputs the current weight reading as
a vehicle tare weight in either the Weight In or Weight Out box.

Traffic Light: Displays push buttons for manual control of traffic
lights. Displays automatically controlled traffic lights.

Unattended Printing: Enables (green) or disables (red) printing of
a ticket for an unattended transaction.

Master Transaction Number: Shows the total number of
transactions. This number cannot be reset.

Load Number: This number can be reset at any time. It
shows the number of transactions since the last reset.

M

T

+
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Data Groups
To make it easier to locate information on the Vehicle Processing
screen, the data is arranged in six groups: Vehicle, Account,
Product, Transaction, Contract, and Amount. The groups contain
yellow input fields where you enter data and gray output fields
where the system displays data.

When you start a new transaction, the cursor appears inside the
first input field. You can move to the next input field by pressing the
TAB key (your system can be set up to use the ENTER key instead
of the TAB key). The cursor cannot move to fields that are not input
fields. You can also move directly to any input field by clicking on
it with the mouse. WinBridge validates the data entered into the
field before moving to the next field. If the data are correct, then the
cursor will move to the next input field. Otherwise, an error dialog
box will appear, and the cursor will not move to the next field until
a valid entry is made.

Vehicle Group
The Vehicle group contains information about a vehicle and its tare
weight:

•  Vehicle: vehicle ID, description, minimum and maximum
weights (if they are enabled), container ID, container weight,
and a Truck Only box to check when a container vehicle does
not have a container attached. The Container combo box
(which lists container IDs) is enabled only if a vehicle has a
container.

•  Tare: a vehicle’s tare weight and pictures of the tractor and
trailer associated with the tare configuration. If more than one
tare weight is stored for a vehicle, use the scroll bar below the
Tare Weight data field to select the appropriate tare weight.

New tare values can be stored by pressing the Store Tare button.
Values will then be saved to the Tare table.
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Account Group
The Account group contains information about the account
(customer or supplier), such as the account ID, name, and
addresses (there can be more than one shipping address).

Product Group
The Product group includes the product ID, description, taxes, and
price per unit (Pr/U).

Transaction
Group

The Transaction group contains information about the current
transaction. It can include the in and out time of the transaction,
the inbound and outbound weights (if the transaction is
completed), and the net weight.

NOTE: If the Truck Only box is checked in the Vehicle data group,
the net weight will be reduced by the tare weight of the container.
The mode of operation (Ship or Receive) can be selected from the
combo box. A conversion unit will be shown if that option is
enabled in the Product table.
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Contract Group
The Contract group contains the contract ID (selectable from a
combo box), the maximum weight authorized for the contract, and
the accumulated delivery weight. These fields are filled only when
an account and a product have been identified.

Amount Group
The Amount group contains data used for computing the final cost
of a transaction. For instance, it can show the price of the weighed
goods, surcharges, taxes, total price, and discount. This data is
displayed only after a weight is entered.

Company and
Carrier Combo
Boxes

The Company ID combo box shows the company ID. Until you
select a company ID, the box will display the first ID in the
database. The Carrier ID combo box shows the carrier ID.



Chapter 2: Vehicle Processing Screen
Push Buttons

(9/00) 2-7

Push Buttons
The following buttons are used on the Vehicle Processing screen:

Use the Accept button to complete a transaction by accepting the
data currently displayed on the Vehicle Processing screen. If the
data are valid and complete, the transaction will be recorded in the
database. If any of the data are invalid (or do not exist in the
database), an error dialog box will appear. If that happens, correct
the invalid data entries and press the Accept button again.

Use the Compute button to recalculate the price or weight for a
transaction after editing the Truck Only, Add Price, or Surcharges
field. The updated information will then be displayed. This option is
used to view the results of a computation before accepting a
transaction. It is also used when new taxes or surcharges are
added: simply press the Compute button to display the new total.

Use the Clear button to clear the Vehicle Processing screen and
move the cursor to the first data field. All data fields are cleared
automatically when a transaction is accepted.

Use the Daily Delivery Weight button to show how much of the
product selected in the product ID field has been weighed on the
current day. WinBridge can be configured to show Received
Weight, Shipped Weight, and Total Weight (received weight plus
shipped weight).

Use the Continue button to process multiple weighings as a single
transaction. It allows you to run a two-pass transaction that
involves (1) weighing more than one product on a single vehicle
or (2) weighing products for more than one account on a single
vehicle. Suppose, for example, that a vehicle needs to pick up
several products for a customer:

1. Weigh the empty vehicle on its first pass over the scale.

2. Load the first product onto the vehicle, take a second-pass
weight reading, and then click the Continue button. This
stores the weight for the product.

3. Load the next product onto the vehicle, and then take another
second-pass weight reading. If more products need to be
weighed, click the Continue button and repeat this step for
each product.

4. When all products have been weighed, click the Accept button
to complete the transaction.
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Remarks
The Remark and Remark2 combo boxes are located to the right of
the Company ID and Carrier ID combo boxes on the sample
Vehicle Processing screen. You can enter remarks related to the
current transaction or select predefined remarks from the combo
boxes.

Spare Fields
Spare data fields are available on the Vehicle Processing screen to
display data that is not stored in the database. Spare fields 10, 11,
12, and 13 are designed so that the text entered into them will
wrap; however, the configurator must remove the borders around
these fields for the wrapping function to work.

Status Bar
The status bar at the bottom of the screen shows the settings of the
Caps Lock, Number Lock, and Scroll Lock keys. It also displays a
brief explanation of the current menu selection or wait messages
and other information.
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3 Creating Database Records

WinBridge
Tables

Before you can use WinBridge to process transactions, you need to
enter information in the database about products, accounts,
vehicles, etc. This information is stored in a series of WinBridge
tables (each table is described later in this chapter). The only limit
to the number of records that you can store in your database is the
amount of hard disk space available on the computer.

The Product, Account, Contract, and Vehicle tables are the four
main WinBridge tables. To view a table, open the Table menu on
the Vehicle Processing screen and click on the desired table.
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Forms
When you select a table from the menu, the first thing you will see
is a form designed to display an individual record from the table.
You can go directly from the Vehicle Processing screen to a form
by placing the cursor in the appropriate ID data field and pressing
the SHIFT+? key. A sample form for the Company table is shown
below.

Each form contains data fields, which are used to enter, view, and
edit information for a record.

•  The yellow data fields must be filled in. They represent the
minimum information required to create a database record.

•  The ID field is the record’s primary key (unique identifier).

•  The white data fields are optional. You can leave these fields
blank when creating a record, but we suggest that you enter
as much information as possible.

NOTE: Do not use an apostrophe (or single quotation mark) in
data field entries. The WinBridge program does not recognize it as
a legitimate character.



Chapter 3: Creating Database Records
Modifying Tables

(9/00) 3-3

Tables
To display all the records stored in a table, click the Query button
on the form’s toolbar and then click the Table button. A sample
Company table is shown below.

Use the scrollbar at the bottom of the table to view all the data in
the table. To search for a specific record, type the ID (or other
information known about the record) in the appropriate data field
on the form. Then click the Query button.

Modifying
Tables

You can modify a table by rearranging rows and columns and by
changing column widths.

To rearrange rows, click on one of the column headings. The rows
will be rearranged so that the items under the heading that you
clicked on are in alphabetical/numerical order.

To rearrange columns, position the cursor on the bottom border of
a column heading until the symbol shown to the left appears. Then
hold down the left mouse button and drag the column to a new
location.

To change the width of a column, position the cursor on the side
border of a column heading until the symbol shown to the left
appears. Then hold down the left mouse button and drag the
column border to the desired width.
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Toolbar
A toolbar is located near the top of each of the forms used to
display individual records from the tables. The push buttons on the
toolbar provide the following functions:

Closes the form.

Clears all data fields and begins a new record.

Recalls all records if all data fields are blank. Any data entered into
a required or optional data field will be used as a filter.

Shows query results in a table. When you highlight one of the
records listed in a table, the highlighted record will be displayed in
the data fields on the form.

Returns to the first record in the query.

Returns to the previous record.

Goes forward to the next record.

Goes forward to the last record in the query.

Inserts a new record once all required fields have been filled.

Accepts changes made to an existing record.

Deletes the current record.
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Special
Buttons

Several push buttons are used to perform special tasks. The
Presets button is available for the main WinBridge tables (Product,
Account, Contract, and Vehicle). The Groups and Sample buttons
are available for the four main tables only if the Advanced Module
is enabled. In the WinBridge Advanced Module, the Presets and
Groups buttons are available for the Carrier table.

The Presets button lets you create an automatic link that connects
a vehicle, a product, an account, and a contract. Once presets
have been defined, you can enter them into the data fields on the
Vehicle Processing screen with a single keystroke (see Chapter 6).
The last preset used will override previously defined presets.

The Groups button appears only if the Advanced Module is
enabled. This button can make it easier to manage your weighing
operations by allowing you to create groups of products, accounts,
contracts, or vehicles. See Chapter 5 for a description of how
groups can be set up and used.

The Sample button appears only if the Advanced Module is
enabled. Pressing this button will display a screen from which you
can determine how and when product samples are to be taken for
an individual product, account, contract, or vehicle.

There are also several push buttons that are discussed in the
sections about the individual tables:

•  The Detail button is covered in the Contract table section.

•  The Shipping button is covered in the Account table section.

•  The Advanced Pricing button is covered in the Product table
section. This button also appears on the Contract Detail table.
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Editing Table
Entries

You can insert new records in a table, delete existing records, and
edit existing records.

Inserting a
New Record

Open the Table menu and select the table into which you wish to
insert a record. The form for that table will appear.

1. Click the New button to clear all data fields on the form and
provide a fresh screen for you to use.

2. Fill in the appropriate data fields. If you do not fill in all
required fields, a “Value not entered in this field” error
message will appear when you try to insert the new record.

3. When you have entered all the information, click the Insert
button. This will enter the new record in the existing table.

A quick way to create a record is to display an existing record that
is similar to the one you want to create. Change the record’s ID
and click the Insert button. This will give you a new record based
on a copy of the existing record.

Deleting an
Existing Record

Open the Table menu and select the table from which you wish to
delete a record. The form for that table will appear.

1. Click the Query button and then click the Table button. This
will display all entries in the table.

2. Double-click on the entry you wish to delete. This will display
the record on the form. Click the Delete button to delete it. You
will then be prompted to confirm the deletion.

Another way to delete a record is to enter its ID in the ID data field
and then click the Query button. Once the record is displayed on
your screen, click the Delete button.

The Sampling and Surcharge tables are the only exceptions to this
procedure. A record in those tables must be marked for deletion by
clicking on it with the right mouse button. Once the record has
been marked, delete it using the DELETE key on the keyboard. An X
will appear at the beginning of the row. Then click the OK button to
accept the deletion.
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Editing an
Existing Record

Open the Table menu and select the table you wish to edit.

1. Click the Query button and then click the Table button. This
will open a table that displays all records.

2. Double-click on the record you wish to edit. The record will be
displayed on the form, and you will be able to edit any of the
fields.

3. When you have finished editing the record, click the Update
button. This will update the existing record so that the
changes will be available immediately.

Another way to edit a record is to enter its ID in the ID data field
and then click the Query button. Once the record is displayed on
your screen, you can edit it and update the record.

The Sampling and Surcharge tables are the only exceptions to this
procedure. For those tables, use the left mouse button to click on
the item you wish to edit. Then type in the changes or use the
combo box to make a change. Once the changes have been
made, click the OK button to accept them.
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Company
This form lets you add, edit, and delete information about each
company that processes transactions on your WinBridge system.
In many cases, only one company will be involved. But there can
be more than one entry if several companies share a scale.

Required Data Fields
Company ID: The primary key for this table.

Optional Data Fields
Name: The name of the company.

Address 1:

Address 2:

City:

State:

Country:

Zip:

Phone:

Fax:

Fiscal Code:
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Load No: A number from 1 to 10 that corresponds to
one of the Load data fields on the Vehicle
Processing screen.

Multiple Loads

The multiple loads feature can be used when you are processing
transactions for several companies. It keeps track of how many
transactions are processed for each company.

1. When inserting or updating a company record, enter a
number from 1 to 10 in the Load No data field on the
Company form. A separate load number should be assigned
for each company.

2. When you process a transaction, make sure that the Load No
box on the Vehicle Processing screen’s toolbar is checked.

3. The number of loads processed for a company will be shown
on the Vehicle Processing screen in the Load data field (see
below) that corresponds to the load number assigned to the
company.

The load number count for each company can be reset to 1 by
using the Reset Loads function in the Transactions section of the
Tools menu.
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Tax
This form is used to store information about taxes. You should
enter Tax table information before you create a Product record, so
that the tax information will be available for use when you fill in the
Product form’s Tax1 and Tax2 data fields.

Required Data Fields
Tax ID: The primary key for this table.

Value: Value of the tax is shown as a percentage.

Optional Data Fields
Description: A description of the tax being defined. Examples:

federal, state/provincial, harmonized, county,
and municipal tax.
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Product
This form lets you add, edit, and delete information about the
different products that you will be weighing.

Required Data Fields
Product ID: The primary key for this table.

Optional Data Fields
Manual
Weighing: Check this box if you wish to be able to enter the

weight of this product manually (it will still be
possible to weigh the product on a scale).

Description: A description of the product.

Stock Level: The amount (in pounds, kilograms, or metric
tons) of the product currently in stock. As the
product is received or shipped, this value will be
updated automatically.

Unit Price: The price of the product per Unit ID. This value is
stored as PR1.
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Unit ID: The primary unit used for weighing the product
(pounds, kilograms, or metric tons).

Price Type: Choose one of the two pricing methods: by
Weight (default price formula is NET*PR1) or by
Pieces (default price formula is PCS*PR1).

Price
Formula: The price formula is created when you insert or

update a record. Price formula variables include
NET (net weight), PR1 (unit price), PCS (pieces),
/,  +, -, *, and #### (numbers).

Minimum
Price: You can set a minimum price for a product. This

price will be used whenever the calculated price
is lower than the minimum price.

Tax1 ID: Taxes defined in the Tax table. Choose from an
existing list or NA if taxes are Not Applicable.

Tax2 ID: Taxes defined in the Tax table. Choose from an
existing list or NA if taxes are Not Applicable.

Conv. Unit: A secondary weight unit.

Conv. Factor: The multiplier used to convert the primary weight
unit to a secondary unit. Conversion Unit and
Conversion Factor work together produce a
second unit used in reporting. Examples:

Unit ID Conv. Factor Conv. Unit

kg 2.2046 lb

lb 0.4536 kg

lb 0.0005 tons

kg 0.001 tonnes

Default
Operation: Choose one of the options: Ship, Receive, or

Either. If you choose Either, then the product can
be both shipped and received.

Surcharges: If the Advanced Module is installed, you can use
the table at the bottom of the screen to assign up
to six surcharges for a product. All preset
surcharges will be used when a price is
calculated for a transaction.

Advanced
Pricing: When you click the Adv Pricing button, the

following form appears:
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Enable Advanced
Pricing: If this option is enabled, then the Advanced

Pricing parameters will be used. If it is not
enabled, then the Base Formula will be used.

Unit Price: Price per unit (from Product form).

The Max and Price columns are used for step pricing only. You can
define up to five steps in a pricing scheme. For each step, enter a
price and the maximum weight for which that price is used.

Fixed Price: Sets a single price per unit for the entire load (for
example, $120 for loads up to 2,000 pounds).

Raw Price: Sets a different price per unit for portions of a
load (for example, $140 for the first 1,000
pounds, $120 for the second 1,000 pounds,
etc.).

Base Formula: This is the same as the Price Formula described
in the Product form (usually NET*PR1).

Clear Formula: Clear the existing formula. A formula must be
entered for the price definition to be accepted.

OK: Save the existing formula or step pricing scheme.

Cancel: Cancel any changes made to the original
formula.
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Account
This form lets you add, edit, and delete information about accounts
(customers or suppliers). The Enabled box must be checked for an
account before you can process transactions for that account.

Required Data Fields
Account ID: The primary key for this table.

Optional Data Fields
Enabled: Check this box to enable the account.

Name: Account name.

Fiscal Code:

Address 1:

City:

State:

Country:

Zip:

Phone:
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Fax:

Person: The name of the contact person at the customer’s
or supplier’s office.

Max. Credit: The credit limit extended to this account. You can
make this a required field by enabling Use Credit
Check in the Processing Parameters form (see
the information about processing parameters in
Chapter 7).

Act. Credit: This field contains the amount of active credit the
account has used to date. As the account uses
credit, this field will update automatically. When
the account makes a payment, this field must be
edited manually. Once the Act. Credit equals
Max. Credit, you will receive the following
message: “Max credit exceeded for Account.” At
this point you must either extend further credit or
cancel the transaction. You can make this a
required field by enabling Use Credit Check in the
Processing Parameters form (see the information
about processing parameters in Chapter 7).

Ticket In: Choose from a selection of predefined tickets to
print when a vehicle enters your facility. If you do
not wish to use an entry ticket, leave this field
blank.

Ticket Out: Choose from a selection of predefined tickets to
print when a vehicle exits your facility. Note:
Ticket In and Ticket Out can be used
independently. You can use a different format for
each ticket.

Info: For entering additional information about the
account.

Discount: A discount (%) allowed for the account. The
price on the ticket will need to be reduced by this
percentage.

Payment: Choose one of the payment types: Cash, Invoice,
or Other.

Operation: Choose one of the options: Ship, Receive, or
Either. If you choose Either, then both shipping
and receiving transactions will be allowed for the
account.
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The Shipping button is an option found only on the Account form.
When you click this button, the Shipping Address form will be
displayed. In this form, you can enter additional shipping
addresses for an account.



Chapter 3: Creating Database Records
Contract

(9/00) 3-17

Contract
This form lets you add, edit, and delete contract information for an
account. Each account can have more than one contract. To use
this table, you must enable Use Contract on the Processing
Parameters form (see Chapter 7).

Required Data Fields
Contract ID: The primary key for this table.

Account ID: Use the combo box to choose from a list of
existing enabled accounts. The account’s record
must already exist in the Account table.

Optional Data Fields
Enabled: Check this box to activate the contract. If it is not

enabled, then the contract will not be available
for use.

Description: A description of the contract.

Other ID: Further clarification of the Contract ID.

Info: Additional information about the contract.

First Deliv.
Date: The date of your first delivery to or from the

account under this contract.
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First Deliv.
QTY: The quantity of the product delivered to or from

the account on the first delivery date.

Expiration Date: The date when the contract expires. If a contract
is used after this date, a warning appears on
screen.

The Detail button is an option found only on the Contract form.
When you click this button, the Contract Detail form will be
displayed. This form provides additional information about the
contract that was selected in the previous screen.

NOTE: It is not necessary to use the Contract Detail form, but we suggest that you enter
as much information as possible about active contracts. You must enter values in all
data fields except Price Formula in order to insert a contract detail record.

Contract ID: The contract ID from the previous form.

Product ID: The product identifier for the product that will be
delivered through this contract. A record for this
product must already exist in the Product table.

Max. Weight: The maximum weight of the product that is
allowed for this contract.

Deliv. Weight: The actual weight of the product delivered under
this contract. This field is automatically updated
when a delivery is processed on the Vehicle
Processing screen.
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Discount: A discount rate to be applied to the product price.
NOTE: If you enter a negative amount, then an
increase is calculated instead of a discount.

Unit Price: The unit price for a product.

Advanced
Pricing: Advanced Pricing is described in the Product

table section. The Advanced Pricing formula is
displayed in the Price Formula field. A push
button is supplied for clearing the formula.

Enabled: Check this box to enable the contract.

Operation: This indicates whether you will ship or receive
this product (you cannot choose both).

Price Type: This indicates whether a product is priced by
weight or per piece.
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Carrier
This form lets you add, edit, and delete information about carriers
that use your weighing operations. A carrier can ship products for
more than one account, and each account can use more than one
carrier. None of the entries is tied to the Account table. The Carrier
form will include Presets and Groups buttons only if the Advanced
Module is installed.

Required Data Fields
Carrier ID: The primary key for this table.

Optional Data Fields
Name: The full name of the carrier.

Address 1:

Address 2:

City:

State:

Country:

Zip:

Phone:

Fax:
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Vehicle
This form lets you add, edit, and delete information about vehicles
that use your scales. If a vehicle is set up as a container-type
vehicle, the system will prompt for the container type when the
vehicle is selected for a transaction. If a container vehicle enters or
leaves without a container, check the Truck Only box on the Vehicle
Processing screen or select a zero-tare container (a container with
zero entered in the Tare data field).

Required Data Fields
Vehicle ID: The primary key for this table.

Min. Legal
Weight: The minimum legal weight of an empty vehicle.

Max. Legal
Weight: The maximum legal weight of a full vehicle.

NOTE: Min. Legal Weight and Max. Legal Weight are required only
when Check Vehicle Weight is enabled in the Processing
Parameters screen (see Chapter 7).
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Optional Data Fields
Container
Vehicle: Check this option if the vehicle requires or can

carry a separate container.

Unattended
Ticket: This check box is used to enable WinBridge to

print tickets while operating an unattended scale
terminal.

Type: Choose Tractor or Trailer.

Description: A short description of the vehicle.

Carrier ID: This combo box is connected to the Carrier table.
If a carrier is using this vehicle, select that carrier
from a predefined list. NOTE: The carrier is not
automatically linked to this field.

Operation: Choose Ship, Receive, or Either. If you choose
Ship, the vehicle can be used only for shipping. If
you choose Receive, the vehicle can be used
only for receiving. If you choose Either, the
vehicle can be used for both shipping and
receiving.

Driver: The name of the vehicle’s driver.

License: The license plate numbers of the vehicle.

Info: Additional information about the vehicle or driver.

Expiration: The date that the vehicle license expires. If the
vehicle is used after this date, a warning appears
on screen.

Transient Vehicles
You can weigh a vehicle that is not listed in your database. To
process the transaction, enter a vehicle ID in the appropriate data
field on the Vehicle Processing screen. When you move the cursor
to another data field, the following message will appear on the
screen: “Unknown vehicle! Is it a transient one?” Click the Yes
button and continue with the transaction.
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Container
This form lets you add, edit, and delete information about
containers. Note that a tare value is required for the container.

Required Data Fields
Container ID: The primary key for this table.

Tare: A manually entered weight for this container.

Optional Data Fields
Description: A description of the type of container.

Info 1: Additional information about the container.

Info 2: Additional information about the container.

A vehicle that uses a container will have separate tare weights for
the vehicle and the container. Indicate that a vehicle can carry a
container by checking the Container Veh box on the Vehicle form.
Create a record in the Container table for each type of container
(including the tare weight). To weigh a container vehicle that does
not have a container attached, check the Truck Only box on the
Vehicle Processing screen or select a container ID that has zero
entered as its tare weight.
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Operator
This form is used to set up users as supervisors or operators. Only
supervisors can change passwords or user information.

Required Data Fields
Operator ID: The primary key for this table.

Level: The level of security for the supervisor or operator
(0-9, zero providing the greatest access). The
supervisor or operator will not be able to use any
WinBridge function that requires a greater
security level than the one assigned here.

Name: The full name of the user.

Password: The user’s assigned password. Only supervisors
can change a password. NOTE: This field is case
sensitive.

Type: Indicate whether the user has Supervisor or
Operator status.

Optional Data Fields
Expiration: Defines when the account is due to expire. This

field is useful if contract or temporary personnel
are employed.
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Function
Enable/
Disable: The specific responsibilities of the user are

defined here. Your configurator can select up to
10 functions (from the 30 available functions
listed in the WinBridge Configurator Manual,
Chapter 7).

NOTE: Be careful when enabling functions. If operators are given
too little authority, they might not be able to do work. If they are
given too much authority, they might be able to delete all the stored
information.

Setting Up Users

1. Enter an ID in the Operator ID field to create a new record, or
click the Query button to update an existing operator or
supervisor record.

2. Set up the user as a supervisor or operator by selecting the
appropriate radio button in the Type group box.

3. Choose a level of access by typing in the appropriate number
in the Level field (0-9, with zero providing the greatest
access). The entry in this field will limit the user’s level of
access regardless of whether the user is set up as a
supervisor or operator.

4. Enter the full name of the user in the Name field.

5. Enter a password in the Password field. We recommend
giving each operator a unique password. Operators cannot
change their own passwords.

6. You can limit the time period for which an operator has
access to the WinBridge system by entering a date in the
Expiration field. When the user tries to login after this date, a
“Password has expired” message will appear on the screen.
This effectively locks the user out of the system until a
supervisor changes the expiration date.

7. If the user type has been set to Operator, you will need to
enable the desired functions in the Function Enable/Disable
group box. Supervisors have access to all functions by
default. Check the boxes corresponding to the functions you
want to enable for the operator. Functions listed in this section
will vary from client to client, depending on how the system is
configured. If you have questions about the availability of a
function or the definition of a function, refer to the WinBridge
Configurator Manual.

8. Click the Insert button to save the new operator/supervisor
record. Or click the Update button to update an existing
operator/supervisor record.

9. Click the Close button to complete this procedure.
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Tare
This table stores tare values for vehicles. Each vehicle can have
more than one tare value. This form is used to provide information
about tares, not to edit the data fields. Notice that there are no
Insert or Update buttons on the toolbar. Tare weights are entered
using the Store Tare button on the Vehicle Processing screen (see
Chapter 7).

Required Data Fields
Vehicle ID: A unique vehicle identifier.

Tare ID: A unique identifier for this tare type.

Tare: The tare weight of the empty vehicle.

Consecutive: The number of the current transaction. WinBridge
numbers each transaction consecutively.

Scale ID: The identifier of the scale being used to measure
the tare value.

Optional Data Fields
Description: A description of the tare or vehicle.

Expir. Date: The date that the tare value for this vehicle
expires. If this field is left blank, the tare will
disappear the following day.
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Remarks
The Remark and Remark2 forms let you add, edit, and delete
remarks to be attached to a transaction.

Required Data Fields
Remark ID: The primary key for this table.

Optional Data Fields
Description: Enter the remark that you want to appear on the

Vehicle Processing screen. Although this field is
not required, we recommend that it be filled in at
all times.
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Groups
This form is used to create groups of accounts (customers or
suppliers), contracts, vehicles, carriers, or products. See Chapter 5
for an explanation of how to create groups and group presets.

Required Data Fields
Group ID: The primary key for this table.

Optional Data Fields
Description: A description of the group.
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Badge and
Short Code

If WinBridge is used in unattended mode, the driver of a vehicle
can enter data at an unattended driver station with a badge or short
code. When the Unattended Module is installed, you can enable
this type of data entry by assigning a badge ID or short code and
linking it to a vehicle, contract, account, or product.

The Table menu on the Vehicle Processing screen includes menu
items for enabling a Badge or Short Code. When you select one of
those items, WinBridge displays a submenu with the following
options: Vehicle, Contract, Account, and Product. Selecting one of
those options displays a Badge Administration or Short Code
Administration form. For example, selecting the Badge menu item
and then the Vehicle submenu item will display the Badge
Administration form shown below.

All eight forms work the same way. Enter a badge ID (or short
code) in the data field, and then use the combo box to link it to a
vehicle, contract, account, or product.
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4 WinBridge Advanced Module

The WinBridge Advanced Module is an add-on software program
that provides additional capabilities.

Extended
Tables

The Advanced Module enables 15 additional tables that can be
used to store information not found in the standard WinBridge
tables. Examples are authorization codes, product grade,
unloading area, etc. To use these tables, open the Extended Tables
menu on the Vehicle Processing screen and select the desired
table. The form for Table 1 is shown below.

The extended tables contain the following fields:

Table ID 10 characters

Description 40 characters

Info1 50 characters

Info2 50 characters

Info3 50 characters
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Two of the data fields (Table ID and Description) are visible on the
Vehicle Processing screen. The Table ID can be selected by using a
combo box. Each table can be set up so that both fields are used
or only the ID field is used. Your configurator can set up each field
that is used according to one of the following options:

•  Optional and verified (present in database) if inserted.

•  Mandatory and verified.

•  Optional and not verified when inserted.

•  Mandatory and not verified.

Expiration Date Validation

An expiration date can be assigned for each extended table. The
date should be entered in the Description field on the extended
table form in a YYYY/MM/DD format.

Each extended table that has been enabled will be listed at the
bottom of the Vehicle Processing screen (see below). If you check
the Validate Date box for a table, WinBridge will check the table’s
expiration date when a transaction is processed.
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Carrier Table
When the Advanced Module is installed, the Carrier table becomes
one of the main tables. It will appear on the Vehicle Processing
screen and offer presets and group presets functions.

Presets
When the Advanced Module is installed, WinBridge’s Presets
functions are added to the Carrier, Container, Remark, Remark2,
Shipping Address, and extended tables. See Chapter 6 for an
explanation of how to use presets.

Group Presets
When the Advanced Module is installed, a Group ID field will be
added to each of the main WinBridge tables. Group presets are
enabled from the Processing Parameters screen. See Chapter 6 for
an explanation of how to use group presets.

Converted
Weights

When the Advanced Module is installed, an additional field is
displayed on the Vehicle Processing screen, showing the weight
converted into another unit. The conversion factor and conversion
unit (visible on the screen) are stored in the Product table.
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Virtual
Indicators

You can process large vehicles that need to be weighed on more
than one scale by setting up a virtual indicator. The virtual indicator
lets you define a new indicator as the sum of two or more existing
indicators. Suppose that scales 1 and 2 are enabled. You can set
up the virtual indicator as scale 3, so that it displays the sum of
the weight from scale 1 and scale 2. Tickets can be printed to
indicate that the weight is from scale 3.

To set up a virtual indicator, select Virtual Indicator from the Scale
menu on the Vehicle Processing screen.

1. Check the Enable Virtual Indicator box on the Virtual Indicator
SetUp form.

2. Enter a Virtual Scale ID number.

3. Use the 1st combo box to select the first scale (scale number
1, 2, 3, or 4) to be summed by the virtual indicator.

4. Use the 2nd combo box to select the second scale to be
summed by the virtual indicator. The 3rd and 4th combo
boxes can be used if you want to sum more than two scales.

5. Click Save to save the virtual indicator setup.
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Advanced
Pricing

The Advanced Pricing function lets you set up a complex price
structure. For example, you might want to charge a lower rate
when larger amounts of a product are purchased. You can access
this function from the Product table and from the Contract Detail
table. That allows you to define an advanced pricing structure for a
product or for an individual contract. Click the Advanced Pricing
button to display the Advanced Price Definition form.

Check the Enable Advanced Pricing box. You can define up to five
steps by entering weight thresholds in the Max column. For each
maximum weight, define a unit price to be used within the weight
range. There are two ways to define the price structure:

•  Fixed Price: The entire load will be priced using the value in
the Price column next to the weight range into which the load
falls. For example, a load weighing 2,000 pounds could be
priced at a fixed rate of $120 per unit.

•  Raw Price: A different unit price will be used within each of the
weight ranges. For example, $140 per unit might be charged
for the first 1,000 pounds, $120 per unit for the second
1,000 pounds, etc. The total price will be calculated
according to this pricing formula.
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Surcharges
The Surcharges function lets you set additional charges for a
delivered load. Surcharges can be assessed by fixed rate ($5), by
weight ($5 per ton), by percentage of price (5% of price), or by
the piece ($5 per piece).

The Surcharges Definition form displays all applicable surcharges.
To reach this form, select Surcharges Definition from the Extended
Tables menu on the Vehicle Processing screen. Although no fields
are marked as required, all fields need to be completed for you to
use a surcharge. Entries can be made directly in the table or
chosen through the use of radio buttons and data fields. To delete
a record, click on it with the right mouse button and then press the
DELETE key on the keyboard.

Data Fields and Buttons
Surcharges ID: Identifies the applicable surcharge.

Type: Choose one of the four radio buttons.

Fixed: A flat rate added to the transaction total.

Percent: A percentage of the total value of the
transaction.

Weight: A dollar value entered per weight unit (for
example: $5.00 per lb).
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Pieces: If Pieces is chosen as the unit of
measure, this type of surcharge would be a fixed
dollar amount per piece (for example: $.50 per
piece).

Value: Enter the dollar value of the surcharge. This entry
depends on the type of surcharge chosen.

Description: A brief description of the surcharge.

Clear: Clear any table entries that are marked with an
arrow (for example, surcharge #5 in the table
shown above).

Exit: Exit this screen.

OK: Save any entry or modification.

New: Add a new entry in the table.

Surcharges are added to the price of the product after a vehicle has
been weighed but before accepting the transaction. To add a
surcharge, press the Surcharges button on the Vehicle Processing
screen. This displays the Surcharges Definition form. Double-click
on the desired surcharge (or surcharges) listed in the table. The
surcharge value will appear in the field next to the Surcharges
button. The total price (with surcharges included) is also shown.
The surcharge is stored in the Add Price field of the Transaction
table.
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Sampling
Sampling is used for government or customer control of the quality
and quantity of materials being processed. Separate sampling
functions are available for the use of a governmental authority and
for the use of the customer. Both functions work the same way, but
they are independent and simultaneous. There are two basic ways
to sample a product:

•  Step sampling whenever a certain weight value or number of
loads is reached for a product, contract, or account.

•  Random sampling within a predefined quantity (for example,
taking a random sample for every 200 tons).

To display the Sampling Definition form, select Sampling Definition
from the Extended Tables menu or click the Sampling button on
one of the main WinBridge tables. Although no fields are marked
as required, all fields need to be completed to define a sampling
operation. Entries can be made directly in the table or chosen
through the use of radio buttons and data fields. To delete a
record, click on it with the right mouse button and then press the
DELETE key on the keyboard.

Data Fields and Buttons
Sample ID: An identifier for the sample.

Description: A description of the sample.
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Sample Mode: Use the combo box to indicate whether samples
will be taken from an inbound or outbound
vehicle.

Sample Type: Step: Choose this radio button if a sample is to
be taken at a specifically set period (for example:
every 10,000 lb or every 200 loads).

Random: Choose this radio button if a random
sample is to be taken within specific guidelines
(for example: any time between 0 and 10,000 lb
or between 10 and 20 loads).

Sample Unit: Load: Choose this radio button if the sampling is
to be done by number of loads.

Weight: Choose this radio button if the sampling
is to be done by weight.

Action: Ticket: Check this box to send the sampling
reminder to the printed ticket.

Block Trans.: Check this box to block the
transaction until the sample has been taken.

Item Type: Choose one of the radio buttons to determine
how sampling will be done. If you select Product
and set a threshold of 10,000 pounds, a product
sample will be taken for every 10,000 pounds of
a product that is processed. If you select Account
and set a threshold of 10,000 pounds, a product
sample will be taken for every 10,000 pounds of
a product that is processed for an account.

Product: Sample by product.

Account: Sample by account.

Contract: Sample by contract.

Vehicle: Sample by vehicle.

Scale: Sample by scale.

WB Station: Sample by WinBridge station.

Threshold: The weight or number of loads at which a new
sample is to be taken.

Item: The name of the product being sampled (the
primary key for this table).

Government sampling is set up from an external program and is
password protected. Only authorized personnel can enter the setup
procedure.

Whenever sampling is called for, the Sampling Event form appears
on the operator’s computer screen indicating that the current load
needs to be sampled. If the system is set up to block the
transaction until a sample has been taken, you will need to enter a
sample result and click OK.
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The sampling function can be set up for the following actions:

•  A special ticket is printed (a standard ReportWindows ticket
with a fixed name: Sampling).

•  The results of the sampling can be introduced in the Sampling
field in the Extended Transactions table (alphanumeric 30).

•  Two-passage transactions are suspended until the sampling
result is introduced. Suspended transactions can be retrieved
by searching all open transactions.

To add the sampling result, use the transaction browser or use the
import utility with the following field order: (1) Result Field, (2)
Owner Field, (3) Sample ID, (4) Transaction Number.
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5 Groups and Group Presets

WinBridge helps you manage your weighing operations more
efficiently by enabling you to create groups and group presets. You
can define groups and group presets for records in the Account,
Vehicle, Contract, Carrier, and Product tables.

•  A Group is a set of records in a WinBridge table that are linked
together because they are all related to a record or records in
another WinBridge table. For example, you might create a
group of vehicles in the Vehicle table that are used by a
particular account in the Account table.

•  A Group Preset is a link between a group and records
belonging to another table. For example, a group of vehicles
can be linked to the account that uses those vehicles.

If you have a large WinBridge database, your operators will need
to search through long lists of records when entering data for
transactions. Groups and group presets can speed up transactions
by limiting the number of choices available to an operator. For
example, if a particular vehicle is used by only four accounts, the
operator will not need to search through a list of all accounts in
your database when that vehicle arrives to begin a transaction.
Instead, the operator can simply choose from a list of the four
accounts linked to the vehicle.

This chapter contains an example that shows how to create groups
and group presets. The procedure involves three steps:

1. Create two or more groups.

2. Add records to the groups.

3. Link the groups.
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Creating a
Group

Suppose Roberts Construction owns five vehicles and has three
subsidiary contracting companies that use the five vehicles to haul
gravel from your quarry. You want to be able to bill the three
companies separately while allowing them to share the five
vehicles.

Begin by creating an account (customer) group for the three
contracting companies.

1. From the Vehicle Processing screen, open the Table menu
and select the Groups table.

2. Type the group name (ROB1) in the Group ID field.

3. In the Description data field, enter a description of the group
(this data field is optional).

4. Select the Customer (account) radio button in the Type
section to define the type of group you are creating.

5. Click the Insert button to create account group ROB1.



Chapter 5: Groups and Group Presets
Adding Records to a Group

(9/00) 5-3

Adding Records
to a Group

Next, add the three subsidiaries of Roberts Construction to the
group that you created. Records for these three companies must
exist in the Account table before you can add them to the group.

1. From the Vehicle Processing screen, open the Table menu
and select the Account table.

2. Locate the record for the first subsidiary (Antique
Construction) and display it on the Account form.

3. Click the Groups button to display the Account Group Setup
form.

4. The ID for Antique Construction (ANT1) will appear in the
Account ID data field. Use the combo box in the Group ID data
field to select the desired account group (ROB1).

5. Click the Insert button to add the account to the group.
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Return to the Account table and follow the same procedure to add
the other two subsidiary companies to the account group. When
you are finished, you should have created an account group with
three members (as shown in the diagram below).

Create a Vehicle Group
Once you have completed the account group, create a vehicle
group (ROBVEH) and add Roberts Construction’s five vehicles to it.
Follow the same procedure that you used to create the account
group and add records to it. The completed vehicle group is shown
in the diagram below.

Roberts Construction
Group Name: ROB1

Antique
Construction

Baroque
Construction

Cosmopolitan
Construction

Roberts Vehicle Group
Group Name: ROBVEH

VEH1 VEH2 VEH3 VEH4 VEH5
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Linking Groups
Once you have created the two groups, you can link them so that
they can be used as presets.

1. From the Vehicle Processing screen, open the Table menu
and select the Account table.

2. Locate the record for one of the accounts that you added to
the ROB1 group and display it on the Account form.

3. Click the Groups button to display the Group Setup form.

4. Then click the Group Presets button to display the Group
Presets form.

5. The account group will be shown in the Account data field. In
the Vehicle data field, use the combo box to display the
vehicle group (ROBVEH) that you want to link to the account
group.

6. Click the Insert button to create the preset for the account
group. You need to complete this procedure for only one of
the three accounts.

7. Follow the same procedure for the vehicle preset. In the
Vehicle table, choose one of the grouped vehicles, click the
Groups button, and then click the Group Presets button. In the
Account data field, select the account group to be linked, and
then click the Insert button. This completes the linking
process.
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Using Group
Presets

The presets can be used to speed up transactions. When you begin
a transaction for one of the Roberts Construction subsidiaries, enter
its Account ID in the appropriate data field on the Vehicle
Processing screen. Normally, you would use the Vehicle data
field’s combo box and scroll through a list of all the vehicles in the
database to select the correct vehicle.

You can simplify the process by using the group presets. After
entering the Account ID, place the cursor in the Vehicle data field
and click the right mouse button (or press the F2 key). A table like
the one shown below will appear on the screen.

The table limits your choices to the five vehicles in the vehicle
group that you have linked to the account.
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6 Operating WinBridge

Processing
Transactions

A transaction can involve one-pass or two-pass weighing.

•  One-pass weighing: Weigh a loaded vehicle and then enter a
stored tare or manual tare to determine the net weight of the
product being shipped or received.

•  Two-pass weighing: Weigh a vehicle once when it is empty
and once when it is loaded to determine the net weight of the
product being shipped or received.

Choose the desired method with the One/Two button on the Vehicle
Processing screen’s toolbar.
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One-Pass Weighing

1. When a vehicle arrives at the scale, enter the information for
the transaction in the data fields on the Vehicle Processing
screen. For a typical transaction, you will need to enter a
vehicle ID, account ID, product ID, and contract ID (if
enabled). There are several ways to enter data:

•  Type values in each field.

•  Select values from the combo boxes.

•  Place the cursor in a field and click the Search button to
display the table related to that field. To select a record
from the table, double-click on it or use the up and down
arrow keys to highlight it and then press the ENTER key.

•  If presets have been defined, enter the ID for the primary
key in the appropriate data field. Then click the Preset
button to enter the preset values in the other data fields.

Press the TAB key (or use the mouse) to move from one data
field to the next. When you move the cursor, WinBridge
validates the data that you just entered. If an entry is not valid,
an error dialog box will appear, and you will need to correct
the entry before proceeding.

2. When one-pass weighing is used, WinBridge determines the
operating mode (Ship or Receive) by reading it first from the
Contract table (if enabled). If the Contract table is disabled,
WinBridge searches the Vehicle table. If the operating mode in
the Vehicle table is Either, WinBridge searches the Product
table.

3. The stored tare for the vehicle appears in the In field for
shipping and in the Out field for receiving. You can manually
override the operating mode by selecting Ship or Receive from
the combo box in the Transaction data group.

4. When all the required (yellow) data fields have been filled in,
click a Scale button on the toolbar to select the scale that the
vehicle is on and take a weight reading. If the weight is to be
entered manually, click the Manual button and enter the
weight when prompted. The net weight will be shown in the
Transaction data group.

5. If surcharges need to be added to the price, click the
Surcharges button in the Amount data group. The Surcharges
Definition screen will appear. Double-click on the desired
surcharge. Click the Compute button to recalculate the price.

6. Click the Accept button to complete the transaction by
accepting the data displayed on the Vehicle Processing
screen. A record of the transaction is saved to the database,
and a ticket is automatically printed or stored.
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Two-Pass Weighing

For two-pass transactions, WinBridge monitors the IN and OUT
weights to determine the operating mode (ship or receive).

1. When a vehicle arrives at the scale, enter the information for
the transaction in the data fields on the Vehicle Processing
screen. For a typical transaction, you will need to enter a
vehicle ID, account ID, product ID, and contract ID (if
enabled). There are several ways to enter data:

•  Type values in each field.

•  Select values from the combo boxes.

•  Place the cursor in a field and click the Search button to
display the table related to that field. To select a record
from the table, double-click on it or use the up and down
arrow keys to highlight it and then press the ENTER key.

•  If presets have been defined, enter the ID for the primary
key in the appropriate data field. Then click the Preset
button to enter the preset values in the other data fields.

Press the TAB key (or use the mouse) to move from one data
field to the next. When you move the cursor, WinBridge
validates the data that you just entered. If an entry is not valid,
an error dialog box will appear, and you will need to correct
the entry before proceeding.

2. When all the required (yellow) data fields have been filled in,
click a Scale button on the toolbar to select the scale that the
vehicle is on and take a weight reading. If the weight is to be
entered manually, click the Manual button and enter the
weight when prompted.

3. Click the Accept button to accept the weight and data that you
entered. This information is stored as an open transaction
until the vehicle returns for a second pass over the scale.

4. When the vehicle returns, click the Transaction button and
double-click the appropriate open transaction (or select the
Vehicle ID and move the cursor to another field to display the
corresponding transaction on the screen).

5. Click the Scale (or Manual) button again to enter the weight.

6. If surcharges need to be added to the price, click the
Surcharges button in the Amount data group. The Surcharges
Definition screen will appear. Double-click on the desired
surcharge. Click the Compute button to recalculate the price.

7. If additional weighings are required for the transaction, click
the Continue button and repeat steps 4 and 5.

8. Click Accept to complete the transaction. A record of the
transaction is saved to the database. A ticket will be generated
(or stored) if the Vehicle table’s ticket option is set.
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Presets
Presets are used to speed up transactions by reducing repetitive,
manual data entry. Suppose a vehicle always carries the same
product for the same account. You can define presets that link the
vehicle to the account and product. Once the presets have been
defined, you can automatically insert account and product
information in the Vehicle Processing screen’s data fields by
clicking the Presets button when you process a transaction for the
vehicle.

Creating Presets
Choose one of the main tables (Contract, Vehicle, Account, and
Product) to use as a primary key (the starting point for the
presets). The Vehicle table is usually the best choice.

NOTE: All values must already exist in their respective tables in
order for this procedure to be completed successfully.

1. Choose the desired main table from the Table menu.

2. Enter the new record or, if you are setting presets for an
existing record, query the database for that record.

3. Click the Presets button to display the Presets screen shown
below. The ID that you selected as a primary key will appear
in the appropriate data field.

4. Select the desired preset values from the combo boxes.

5. Click the Insert button to save a new preset record. Click the
Update button to save changes to an existing preset record.
Then close the tables.
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Using Presets
1. Place the cursor in the Vehicle Processing screen data field

that was chosen as the primary key (for example, the Vehicle
ID field if the Vehicle table was the starting point for creating
the preset) and enter the appropriate ID.

2. Click the Preset button.

3. All the information currently stored in the presets will be
entered in the appropriate data fields on the Vehicle
Processing screen. Except for the primary key, these entries
can be manually overridden for a transaction.

If Automatic Preset is enabled in Processing Parameters, the
presets will be entered automatically without clicking the Preset
button. Simply enter the ID that you used as a primary key in the
appropriate data field. As soon as you move the cursor to another
field, the presets will appear.
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Storing Tare
Weights

You can store a tare weight for a vehicle and use it when
processing one-pass weighing transactions.

1. To store a tare weight, select a vehicle in the vehicle ID field of
the Vehicle Processing screen.

2. Then move the cursor to another field. If a record for the
vehicle exists in the database, the Store Tare button becomes
active. The Vehicle data group (shown below) will display
tare information. If more than one tare weight is stored for a
vehicle, use the scroll bar below the Tare Weight data field to
select the appropriate tare weight.

3. Click the Store Tare button on the Vehicle Processing screen to
display the Tare form shown below. The box on the left lists
the scales that are enabled.

4. If you want to enter a tare weight manually, highlight MAN in
the list box and enter a tare weight in the data field to the
right. Then click the OK button.

If you want to weigh an empty vehicle and store that weight
as a tare, highlight the number of the scale on which the
vehicle is currently being weighed and then click the OK
button. The tare weight will be entered automatically.



Chapter 6: Operating WinBridge
Storing Tare Weights

(9/00) 6-7

5. When you click the OK button, the Tare Setup form will
appear. Make sure that the tare information is correct. Enter a
Tare ID and the number of days (Duration Days) for which the
tare will be saved. Then click the Save button to save the
values and insert them in the Tare table.

6. If you click the Use Virtual Indicator button on the Tare form,
the following form will appear to show you the tare weights
for the scales that are being summed by the virtual indicator.
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Printing Reports
and Tickets

The Report/Ticket menu on the Vehicle Processing screen provides
access to a list of reports that have been configured for printing.

Print Report
Select Print Report from the Report/Ticket menu to display the form
shown below. It lists the name and description of each existing
report.

1. Highlight one of the existing reports.

2. Click the Print button to produce a paper copy of the ticket,
click the View button to display it to your computer screen, or
click the To File button to output the report to a file.
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Standard Reports
The WinBridge program provides a selection of standard sample
reports that you can use. If the Report Module is installed, you can
customize reports to meet your specific needs. Standard reports are
listed in the following tables.

Standard WinBridge Reports

Report Name Description Fields Included

CARRIER Carrier file list Carrier ID, Name, Address1, Address2,
City, State, Zip, Country, Phone, Fax

CASHREP Cash report by operator Transaction #, Account ID, Product ID,
Remark, Transaction Total, Deposit
Received

COMMA Comma delimited report
(EDI)

Account, Product, Vehicle, Wt, Status

COMPANY Company file list Company ID, Name, Address1, Address2,
City, State, Zip, Country, Phone, Fax

COMPLETED Completed transactions Transaction #, Vehicle, Account ID,
Material, Date/Time, In Wt, Out Wt, Net Wt

CONTRACT Contract file list Contract ID, Account ID, Other ID, Info,
Description, Enabled, Initial Stock, Initial
Date, Expiry Date

CUSTOMERS Customer file list Account ID, Account, Ticket In, Ticket Out,
Type, Payment, Phone, Contact, Credit Left

CUSTPROD Date-specific daily report
sorted by customer and
product

Transaction #, Vehicle ID, Remark,
Date/Time, Wt, Amount, Discount,
Surcharge, Tax1, Tax2, Deposit, Balance

DAILY REP Transactions sorted by
customer and product

Transaction #, Vehicle ID, Remark,
Date/Time, Wt, Amount, Discount,
Surcharge, Tax1, Tax2, Deposit, Balance

DAYREP Deposit report sorted by
operator

Transaction #, Account ID, Product ID,
Remark, Transaction Total, Deposit

GRAPH List of completed
transactions

Transaction #, Vehicle ID, Account ID,
Material, Date/Time, In Wt, Out Wt, Net Wt.

MULTI Multiweigh ticket Transaction ticket information

OPEN List of open transactions In Date, Vehicle, In Wt, Transaction #

PRODUCT Product file list Product ID, Description, Price Formula,
Unit Price

PAGEBREAK Transaction report with
page break per customer

Account, Product, Transaction, Date, Net
Wt, Operation, Total Amount $
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SSM00002 Transactions sorted by
account and product

Account, Product, Transaction, Date, Net
Wt, Operation, Total Amount

TOT-VEH Vehicle totals with
average weight

Transaction #, Transaction, Date, In Wt, In
Scale, Out Wt, Out Scale, Net Wt

TRAN-PROD Date-specific transaction
report sorted by product

Product, Account, Transaction, Date, Net
Wt, Operation, Total, Deposit, Balance

TRANSACTIO Date-specific transaction
report sorted by product,
company, contract,
account

Transaction #, Company, Account,
Vehicle, Product, Net Wt, Date

T.SAMPLE Sample ticket with pricing Transaction ticket information

T.SAMPLE2 Sample ticket without
pricing

Transaction ticket information

T.SAMPLE3 Sample ticket without
pricing and container

Transaction ticket information

UNDOIN Report for modified
transactions

Transaction Ticket Information

UNDOOUT Report for modified
transactions

Transaction Ticket Information

VEHICLE Vehicle file list Vehicle ID, Description, Tare ID, Tare Wt

WBS00001 Transactions sorted by
account and product

Account, Product, Transaction, Date, Net
Wt, Operation, Total Amount

WEEKREP Transaction search report Transaction #, Company, Customer,
Vehicle, Product, Net Wt, Date

WORKREP Transaction search report Transaction #, Company, Customer,
Vehicle, Product, Net Wt, Date

INVOICE Invoice export file for
Quickbooks

Transaction, Transaction Type, Invoice
Title, Invoice Memo, Document #,
Account, Amount, Name, Address, Terms,
Price, Quantity

X-CUSTLIST Customer setup file for
Quickbooks

Customer, Name, Address, Phone, Fax,
Contract, Limit

X-ITEM/ACC Item account setup file for
Quickbooks

Account, Name, Account Type, Invoice
Item, Invoice Item Type, Description, Price
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Forestry Reports

Report Name Description Fields Included

CONTRACTOR Contractor file list Contractor ID, Description

CUTBLOCK Cut block file list Cut Block ID, Description

DECK Deck/Yard file list Deck/Yard ID, Description

DESTIN-FOR Destination file list Destination ID, Description

MILL Mill file list Mill ID, Name, Address1, Address2, City,
State, Zip, Country, Phone, Fax

SPECIES Species file list Species ID, Name, Info1, Info2

STRATUM Stratum file list Stratum ID, Description

TIMBERMARK Timbermark file list Timbermark ID, Description

TRANS-FOR Date-specific transaction
report sorted by stratum,
mill, contractor, and truck

Transaction #, Mill, Contractor, Truck,
Stratum, Net Wt, Date

Agriculture Reports

Report Name Description Fields Included

GRADE Product grade file list Product Grade ID, Description

SILO Silo location file list Silo Location ID, Description

UNLOAD Unload area file list Unload ID, Description

Aggregate Reports

Report Name Description Fields Included

CARRIER-CO Date-specific transaction
report sorted by carrier

Account, Product, Contract, Transaction,
Date, Net Wt, Operation, Total Amount $

Sand and Gravel Reports

Report Name Description Fields Included

D.METHOD Delivery method file list Delivery Method ID, Description

D.SITE Delivery site file list Delivery Site ID, Description

D.ZONE Delivery zone file list Delivery Zone ID, Description

GRADE Product grade file list Product Grade ID, Description
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Concrete and Asphalt Reports

Report Name Description Fields Included

BATCHID Batch ID file list Batch ID, Description

PRODINFO Product Information file
list

Product Information, Description

Waste Reports

Report Name Description Fields Included

DESTIN Destination file list Destination ID, Description

ORIGIN Origin file list Origin ID, Description

Landfill Reports

Report Name Description Fields Included

CELL.LOC Cell location file list Cell Location, Description

Recycling Reports

Report Name Description Fields Included

GRADE Product grade file list Product Grade ID, Description

Recycling, Transfer Station, MERF/RRF Reports

Report Name Description Fields Included

DEL-LOC Delivery location file list Delivery Location, Description

UNLOAD Unload area file list Unload ID, Description
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Multi Report Tag
The Multi Report Tag function lets you define and store print
operations that include more than one report. Select Multi Report
Tag from the Report/Ticket menu to display the Multi Tag Reports
form.

1. In the combo box, assign a Multiple Reports ID for the
operation you are defining.

2. In the list box, highlight the report(s) you want to run.

3. Select a Destination: Print to print the report, View to view it on
the computer screen, or To File to output it to a file.

4. Select an Execution time for running the report: Immediate,
Delayed (specify a date and time in the data fields), or End of
Day Operations.

5. Click the Run button to run the report at the specified time.

6. Click the Save button to store the operation that you defined.
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Print Ticket
To print a ticket automatically when a transaction is accepted, you
need to (1) enable the Print Ticket processing parameter and (2)
select a ticket format. You can select a format for inbound and/or
outbound tickets on the Account table form. You must select a
format for each account that you want to print tickets for. You can
also print a ticket for a transaction by selecting Print Ticket from the
Report/Ticket menu. The form shown below will appear.

1. Enter IDs in the data fields and set the radio buttons to qualify
your search for the transaction you want to print.

2. Then click the Query button, and any transactions that meet
your qualifications will be displayed in the table at the bottom
of the form.

3. Highlight the desired transaction and click the Print button.

Last Ticket
Select Last Ticket from the Report/Ticket menu to reprint the ticket
associated with the most recent transaction.



Chapter 6: Operating WinBridge
Managing the Database

(9/00) 6-15

Managing the
Database

The Database menu on the Vehicle Processing screen allows you
to backup the WinBridge database, export data from the database,
and import data to the database.

Backup
Select Backup from the Database menu to display the Backup form.

1. Use the combo box to choose the drive and the list box to
choose the directory in which you want to place the backup
file.

2. Click the Backup button to begin the operation. WinBridge will
automatically save the file with a *.BKP extension.

To find out when the database was last backed up, click the View
button.
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Export
You can export entire tables or individual columns of a table for
use in accounting programs or other software. Select Export from
the Database menu to display the Select Table form.

1. Use the combo box at the top of the form to select a table. The
table’s columns will be listed in the window on the left.

2. Highlight the columns that you want to export and use the >
arrow button to move them to the window on the right.

3. Click OK to export the columns listed in the window on the
right.

4. The Export File window will be displayed. Specify the name of
the file and the directory in which you want to save the
exported data. Then click OK. The function produces two files:
a file (with a *.EXP extension) for the description of the
columns and a file (with a *.DAT extension) for the actual
data.

•  The transactions files are Exptrans.exp and
TYYYMDD.dat.

•  The extended transactions files are Extdtra.exp and
E1YYMDD.dat.
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Import
This is the reverse of the export procedure. When you select Import
from the Database menu, the Open Import Info File window
appears. You have to choose the description file (*.EXP extension)
and the data file (*.DAT extension) to import the data from an ASCII
file into the WinBridge database.
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Global Import
and Export

This function allows a supervisor to import or export all the
database tables at once. Select Global Import or Global Export from
the Database menu.

On both the Global Import and Global Export forms, you can
choose not to import/export Transaction, Counter, and Parameter
tables (refer to the WinBridge Configurator Manual for more
information about these tables). The export operation generates an
ASCII file that contains all the tables in the database.

Database
Speed

After you have processed many transactions, the WinBridge
database can slow down. To speed up a slow database, re-index it
by running the Wbstrpr.exe file in the WinBridge directory. At the
“Are you using Network Database Configuration” prompt, click Yes.
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Managing
Transactions

WinBridge automatically creates a record of each transaction that
you process. It helps you manage these records by keeping track
of the status of each transaction and by enabling you to modify,
void, and export transactions.

Transaction
Status

The current status of each transaction is indicated by the following
status codes:

A Active or open transactions (only the first weighing has
been made). These transactions are kept in the database
no matter how old they are.

C Completed or closed transactions (two weighings have
been made). These transactions will not be erased from the
database, even after the maximum number of days.

X Completed transactions that have been Exported. Because
these transactions have been copied to an export file
(*.DAT), they will be erased from the database after the
maximum number of days.

M Transactions that were Modified with the Modify function
(some data were corrected in the transaction). These
changes have also been logged in the W&M log file.

Y Modified transactions that have been exported. When they
are imported back into the database, the Y status
distinguishes them from completed transactions.

V Transactions that were Voided with the Browse & Void
function.

W Voided transactions that have been exported. When they
are imported back into the database, the W status
distinguishes them from completed transactions.

Transactions with a V, M, X, W, or Y status are kept in the
database until the number of stored days expires (specified in the
Processing Parameters screen).

Statuses W and Y avoid confusion when you import transactions
back into the database to run reports on them.
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Modifying
Transactions

Modifying a transaction creates a new transaction number. The
status of the old transaction number will be changed to M
(modified). Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Modify Transaction from the
submenu to display the Modify Transaction form.

1. To qualify your search for the transaction that you want to
modify, enter a transaction number, enter IDs in the data
fields, or set the radio buttons.

2. Click the Query button to display the results of the search in
the table at the bottom of the form.

3. Highlight the transaction that you wish to modify, and then
click the Modify button.

4. Information about the transaction will be displayed in the data
fields on the Modify form. Change any of the data in the
yellow fields. You cannot make changes to the blue fields.

The Modify form lets you view the individual weighings for a
multi-weigh transaction. Use the Prev and Next buttons to
scroll through the weighings.
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5. Click the Check button to make sure the changes are
permitted.

6. To save the changes, click the Modify button.

7. To confirm the process, click OK when the prompt appears.

8. Click the Exit buttons to close both Modify forms.

When you modify a transaction, the record for the original
transaction is kept in the database with an M status (to indicate
that it has been modified).

A new record (with a new transaction number) is added to the
database. It has a C (completed) status and includes the changes
that you made.

NOTE: You can modify the following fields by entering the changes
in the table at the bottom of the Modify Transaction form: Remark,
Remark2, Spare 1 to Spare 6, Corrected Weight, Corrected Price,
Carrier, Table 1 to 15 ID, Table 1 to 15 Description, and Sampling
Results.
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Voiding
Transactions

You can void a transaction that has not been completed. Select
Transactions from the Tools menu on the Vehicle Processing
screen. Then select Browse & Void to display the Transaction
Browser form. Completed transactions can be modified but cannot
be voided.

1. Enter a transaction number, enter IDs in the data fields, or set
the radio buttons to qualify your search for the transaction that
you want to void.

2. Click the Query button to display the results of the search in
the table at the bottom of the form.

3. Highlight the transaction that you wish to void, and then click
the Void button.

4. To confirm the process, click OK when the prompt appears.

5. Click the Exit button to return to the Vehicle Processing screen.
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Weight Correction
Factor

You can change an invoiced price by applying a correction factor
to the net weight.

1. Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Weight Correction Factor to
display the Transaction Browser form.

2. Enter IDs in the data fields or set the radio buttons to qualify
your search for the transaction that you want to correct. Then
click the Query button to display the results of the search in
the table at the bottom of the form.

3. Highlight the transaction that you wish to correct, and then
click the Correct button to display the Weight Correction form.

4. In the Correction field, enter the weight to be subtracted from
the net weight. If you enter a negative number, it will be added
to the weight. To subtract a percentage of the weight, enter the
percentage in the Correction field and check the percentage
box below it.

5. Click the Try button to display the corrections on the form.

6. Click the OK button to accept the changes.

For multi-weigh transactions, use the Prev and Next buttons to
select an individual weighing. If you are correcting more than one
weighing in a transaction, you must click OK for each change.
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Exporting
Transactions

This function lets you copy completed transactions to an external
ASCII file. Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Export Transaction to display the
Transaction Data Export form. Enter a beginning and ending date
for the transactions to be exported. Then click the Export button.

Reset Counter
Each weighing transaction is numbered consecutively. Three
transaction numbers are shown on the Vehicle Processing screen:

Master Transaction Number: The total number of transactions that
have been processed by your WinBridge system. This number
cannot be reset.

Transaction Number: The number assigned to the current
transaction. This number can be reset, but you must export all data
from the database before you reset it.

Load Number: A transaction number that can be reset without
exporting data. It can be used to keep track of the number of
transactions per week, month, or other period.

To reset the transaction number to 1, select Transactions from the
Tools menu and then select Reset Counter.

To reset a load number to 1, select Transactions from the Tools
menu and then select Reset Loads for the desired load number.

NOTE: When you reset the transaction number, the same
transaction number will be used for more than one transaction.
This might not be legal for some applications.
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7 WinBridge Settings and Tools

Setting Up
Scales and
Traffic Lights

A window like the one shown below appears on the computer
screen to display weight readings from each scale that is enabled.

If your system is configured for continuous data transmission
mode, this window will always be visible. If the system is in
demand mode, the window will not be displayed. In both modes
you can view the weight by clicking the Scale button on the Vehicle
Processing screen.

A Pass Zero function prevents you from starting a weighing
transaction until the scale returns to zero after the previous
transaction has been completed. This function is enabled from the
Processing Parameters form. If Pass Zero is enabled and you try to
start a second transaction before the scale has returned to zero,
you will hear a beep and the weight will not be read. Then you will
have to return the scale to zero value and repeat the transaction.
When the scale is opened, a message on the status bar indicates
whether the Pass Zero function is enabled.

Scale Menu
The Scale menu on the Vehicle Processing screen is used to
control the scales and traffic lights. The main Scale menu options
are listed below:

Open: Opens the scale window.

Close: Closes the scale window.

Print: Sends a print command to the terminal associated with the
scale. If the terminal is connected to a printer, it prints a ticket
showing the current weight on the scale. This command works in
demand mode only.

Zero: Resets the scale to zero.
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Reset: Resets the scale. This closes the connection to the port that
is being used and then reopens it. Reset should be used when
there are problems reading data from the scale.

Virtual Indicator: Lets you define a new indicator as the sum of two
or more existing indicators. This option is discussed in Chapter 4.

Scale 1,2,3,4: Lets you define how each scale is configured. You
can enable/disable the scale, set the data transmission mode
(continuous, demand, or host), set traffic lights for automatic or
manual operation, and set up unattended weighing stations. When
you click one of the scales listed in the menu, the Scale Setup form
will appear.

1. To enable a scale, check the Scale Enabled box and then
enter a Scale ID and scale Address. Click the Sampling button
if you want to define a sampling operation for the scale.

2. Set the scale mode (continuous, demand, or host) by
selecting one of the radio buttons. If continuous mode is
selected, you can enable or disable the use of checksum.
Click the Port button to configure a communication port.

3. Enable any traffic lights that will be used before and/or after
the scale (see the next section for details about setting up
traffic lights).

4. If an unattended terminal will be used, check the appropriate
boxes and configure a communication port.
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Traffic Lights
WinBridge can be configured to control traffic lights that are used
with a vehicle scale. The traffic lights switch can be configured for
automatic (controlled by WinBridge) or manual control. If manual
control is selected, the Vehicle Processing screen will display red
and green push buttons that the operator can use to switch the
lights. A function key can be assigned to the button, so that
pressing the function key sends the string that switches the lights.
A communication port must be defined for automatic or manual
control of lights.

Automatic Lights Control
Check the Automatic Lights box on the Scale Setup screen and
click the Automatic Strings button. In the window that is displayed
below, you can set a threshold weight value and enable the events
that will activate the traffic lights.

The following table shows the typical settings:

State Description Typical Setting

Under Threshold No truck on scale Green (L)

Over Threshold Truck on scale Red (C)

Over and Stable Truck stabilized on scale Red (C)

Transaction Accepted Transaction accepted Green (L)

Threshold Value Weight indicates that truck is on scale 1000

When a vehicle is weighed, WinBridge sends a string of characters
to the traffic lights via a serial port. The system can detect four
events:

1. Under: The weight is under the threshold value (stable or not).

2. Over: The weight is over the threshold value.

3. Stable: The weight is over the threshold value and is stable.

4. Accepted: The transaction has been accepted.
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Each of these events can be assigned to a different serial port.

•  Communication via the serial port does not involve any
communication protocols. The character strings are sent
without additional control characters.

•  This function does not support the split-weighing mode.

Manual Lights Control
Check the Manual Lights box on the Scale Setup screen and click
the Manual Strings button. In the window that is displayed below,
you can enter the strings for switching two sets of lights on and off.

Configure the red and green lights according to the setup at the
customer’s facility. Usually, red is the first two bits of the final word
sent to the traffic light and green is the last two bits of the word.
Information sent to the traffic light is sent in four bits, two for red
and two for green (xxxxRRGG, where xxx is configuration
information). Configure the in and out light strings. If you are using
the control card developed by MT-Sweden, C=red and L=green.
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Processing
Parameters

You can set system defaults from the Processing Parameters
screen. To display this screen, select System Parameters from the
Tools menu, and then select Processing.

Defining the Default Weight Unit
Choose one of the units of measure listed in the Unit combo box:
kg, lb, mt (metric tons).

Enabling Ticket Printing
Check the Print Ticket box in the Enable/Disable section. This will
enable WinBridge to print a ticket automatically when a transaction
is completed.

Logging Transactions to the Printer
Check the Log Printer box in the Enable/Disable section. When Log
Printer is enabled, the weight captured by the scale will be sent to
the log printer every time the Accept button is clicked. The combo
box is used to select a printer port. The Test Log Printer push
button allows you to test the ticket printer.
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Enabling Weight Checking
Check the Check Vehicle Weight box in the Processing section to
enable WinBridge to check the maximum and minimum vehicle
weights stored in the vehicle table. If a vehicle is over weight, the
transaction is not allowed.

Enabling Contracts
Check the Use Contract box in the Processing section to enable the
contract functions. A contract will then be required for every
transaction unless the Contract Can Be Blank box is checked.

Leaving the Contract Field Blank
Check the Contract Can Be Blank box in the Processing section to
allow the operator to leave the Contract field blank when
processing a transaction. This option makes it possible to leave the
Contract field blank without disabling Use Contract. It lets you use
contracts for some transactions and not use them for others.

Checking Delivery Weight
Check the Check Deliv. Weight box in the Processing section to
enable WinBridge to check the delivery weight of a vehicle.

Enabling Shipping Addresses
Check the Use Shipping Address box in the Processing section to
enable the use of shipping addresses for transactions.

Enabling Credit Check
Check the Use Credit Check box in the Processing section to
enable credit checking. This will cause WinBridge to search the
Max. Credit and Act. Credit fields in the Customer table. If the
maximum credit is exceeded, then WinBridge will inform the
operator and prevent the transaction from being completed until the
available credit is increased.

Enabling Vehicle Blocking
Check the Over Weight No Block box in the Processing section to
prevent WinBridge from blocking a transaction when the vehicle is
over weight. If the box is left blank, WinBridge will check the
maximum vehicle weight shown on the Vehicle Processing screen.

Enabling Automatic Presets
Check the Automatic Preset box in the Processing section to enable
WinBridge to enter presets automatically in empty data fields for
which presets have been defined. The Automatic Preset function
works for the main tables and extended tables.

Enabling Weighings Log
Check the Log Scale Control box in the Processing section. This
enables a weighings log function that automatically detects when a
vehicle is on the scale and sends messages to the screen and
alarms file if a regular weighing is not made. Two events can be
logged: (1) a vehicle passed over the scale and no stable weight
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was detected and (2) a vehicle passed over the scale and a stable
weight was detected (the weight is indicated).

Switching ENTER and TAB Key
When you check the Enter To Tab box in the Processing section,
the ENTER key will be used instead of the TAB key to move the
cursor between data fields on the Vehicle Processing screen. If this
box is checked, you will not be able to use the ENTER key for any
other purpose (for example, you will have to use the mouse to
accept a weight). If the box is not checked, the TAB key will be
used to move the cursor between data fields.

Enabling Group Presets
Check the Enable Group Presets box in the Processing section if
you want to be able to use group presets.

Enabling Multiple Loads
Check the Use Multiple Loads box in the Processing section to
enable WinBridge to track the number of transactions processed for
each company to which you have assigned a load number. A load
number is assigned from the Company form, and the number of
transactions will be displayed on the Vehicle Processing screen.

Displaying Pricing Information
Check the Show Pricing box in the Processing section to display
pricing information on the Vehicle Processing screen, Product
table, Account table, and Contract table. This box provides a
simple way to show or hide all of the data fields related to pricing.

Editing Alarm Times
In the Log and Alarm section, enter the number of days that you
want the system to keep a record of alarms.

Editing the Transaction Export Interval
In the Transaction section, specify the number of days between
transaction exports and the number of days you want to keep the
transactions that are stored in the database. The export option does
not delete transactions from the database. It exports completed
transactions to another part of the database, allowing room for the
active transactions.

Enabling Pass Zero
Check the Enable Pass Zero box in the Scale section. This option
requires the scale to return to zero before allowing the next vehicle
to be weighed. If this option is disabled, the Minimum Weight
option is used. The Minimum Weight option requires that the scale
reach the minimum weight that is entered in the data field
(negative values are acceptable) before weighing the next vehicle.

Disabling Database Validation
In the Disable Controls on section, select the fields for which you
do not want database validation to be required: Vehicle, Account,
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and Product. This will allow entries to be inserted manually at the
Vehicle Processing screen.

Enabling Pricing on Screen
Check the Only Cash Customer box in the Pricing On Screen section
to configure WinBridge to show price data on the Vehicle
Processing screen only for cash customers. When this function is
enabled, price data for other customers will be stored in the
database but not shown on screen.

Enabling Weighing Modes
Use this section to enable the one-pass weighing modes you want
to use. Checking the One Passage box allows WinBridge to
automatically apply a stored tare weight so that a vehicle can be
weighed in one pass over the scale. If there is no stored tare weight
for a vehicle, WinBridge will automatically switch to two-pass
weighing for the vehicle. Checking the Use Manual tare box allows
WinBridge to weigh a vehicle in one pass over the scale by
prompting the operator to enter a tare weight manually. Both boxes
must be checked to allow one-pass weighing in unattended mode.

Taking Information on the Second Pass Only
By default, all vehicle, contract, account, and product information
required for two-pass weighing must be entered when a vehicle
makes its first pass over the scale. You can change this so that
some information can be entered on the second pass. Check the
boxes in the Data in 2nd Weighing section that correspond to the
types of information (Contract, Account, Product) that you want to
enter when a vehicle makes its second pass over the scale. When
you process a vehicle, enter only the information required on the
first pass (Vehicle information must be entered on the first pass),
and then click the Accept button. When the vehicle returns, fill in
the remaining required information, and then click the Accept
button to complete the transaction.

Setting Default Operations
In the Default Operation section, choose a default by selecting the
Ship or Receive radio button. Select Either if you want to be able to
set the mode of operation manually for each transaction.

Split Weighing
SPLIT WEIGHING IS NOT WEIGHTS AND MEASURES APPROVED. It
is disabled by default; however, you can enable it for Non-Weights
and Measures processing. To use split weighing, click the Split
button on the Vehicle Processing screen. The system will
automatically ask if you are ready to weigh the trailer. Select OK
and the scale to be used, or enter the weight value manually
(select Manual button). See the WinBridge Configurator Manual for
information about installing this option.
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Tools
The Tools menu on the Vehicle Processing screen provides access
to forms that allow you to view a transaction log, display alarm
settings, view weights registered on the scales, set up automatic
procedures, and configure data to be sent from the WinBridge PC.

WM Log
Select WMLog from the Tools menu to display the Weights &
Measures Transactions Log File. This file stores every transaction
that is made on WinBridge for Weights & Measures certification. It
is a locked file that cannot be changed or deleted.

Click the Query button to search for transactions. You can limit a
search by entering a transaction number, range of dates, or status.
The results of a search are shown on the Transaction Data form.
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Display Alarm
Settings

Select Alarms Log from the Tools menu to display the View Alarm
and Log File form. Use the Facility and Severity check boxes to
select the type and severity of past alarms that you want to view.
Choose the date desired. Then click the Query button to display the
alarm messages.
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End-of-Period
Operations

To set end-of-period operations, select System Parameters from the
Tools menu. Then select Customize Process and End Operations to
display the form shown below.

Checking the boxes will enable the following operations:

End of work: A report named WORKREP is executed. It includes a
filter for the transactions run by the current operator.

End of day: A report named DAYREP is executed. It includes a filter
for the transactions run on the current day.

End of week: A report named WEEKREP is executed. It includes a
filter for the transactions run during the current week.

Backup Database: A start backup message will appear every time
an operator logs out.

Export Transaction: A transaction export message will appear every
time an operator logs out.

The following format is used for the transaction export file
(Exptrans.exp):

TRANSACTION

WB_Identifier,TRANS_NO,STATUS,VEHICLE_ID,CONTAINER_ID,COM
PANY_ID,ACCOUNT_ID,PRODUCT_ID,CONTRACT_ID,OPERATION,R
EMARK,SHIP_ID,PAYMENT,WT_UNIT,TARE_ID,CONTAINER_TARE,IN
_SCALE,IN_WEIGHT,IN_CONSEC,IN_DATETIME,IN_OPERATOR_ID,O
UT_SCALE,OUT_WEIGHT,OUT_CONSEC,OUT_DATETIME,OUT_OPER
ATOR_ID,PIECES,NET_WEIGHT,AMOUNT,ADD_PRICE,TAX1,TAX2,T
OTAL,V_OPERATOR_ID,TRANSIENT,TRANS_UNDO_ID,SPLIT_LOAD,
DISCOUNT,SPARE2,SPARE1,SPARE3,SPARE4,REMARK2,SPARE5,S
PARE6,TRUCK_ONLY,LOAD_NO,MASTER_TRANS_NO,SPARE10,SP
ARE11,SPARE12,SPARE13,WEIGHMENT,SAMPLE_ID,SAMPLE_OW
NER,SAMPLE_RESULT,TICKET_IN,TICKET_OUT
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NULL,NUMERIC,CHARACTER,CHARACTER,CHARACTER,CHARACTER
,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,C
HARACTER,CHARACTER,CHARACTER,NUMERIC,NUMERIC,CHARACT
ER,NUMERIC,NUMERIC,DATE,CHARACTER,CHARACTER,NUMERIC,N
UMERIC,DATE,CHARACTER,NUMERIC,NUMERIC,NUMERIC,NUMERIC
,NUMERIC,NUMERIC,NUMERIC,CHARACTER,CHARACTER,NUMERIC,
NUMERIC,NUMERIC,CHARACTER,CHARACTER,CHARACTER,CHARAC
TER,CHARACTER,NUMERIC,NUMERIC,NUMERIC,NUMERIC,NUMERI
C,CHARACTER,CHARACTER,CHARACTER,CHARACTER,NUMERIC,CH
ARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER

The following format is used for the extended transaction export file
(Extdtra.exp):

EXTD_TRANS

WB_Identifier,TRANS_NO,TBL1_ID,TBL1_DESCR,TBL2_ID,TBL2_DE
SCR,TBL3_ID,TBL3_DESCR,TBL4_ID,TBL4_DESCR,TBL5_ID,TBL5_
DESCR,TBL6_ID,TBL6_DESCR,TBL7_ID,TBL7_DESCR,TBL8_ID,TBL
8_DESCR,TBL9_ID,TBL9_DESCR,TBL10_ID,TBL10_DESCR,TBL11_
ID,TBL11_DESCR,TBL12_ID,TBL12_DESCR,TBL13_ID,TBL13_DES
CR,TBL14_ID,TBL14_DESCR,TBL15_ID,TBL15_DESCR,CARRIER_I
D,CONVER_UNIT,CONVER_WEIGHT,IN_SCALE1,OUT_SCALE1,IN_S
CALE2,OUT_SCALE2,IN_SCALE3,OUT_SCALE3,IN_SCALE4,OUT_SC
ALE4,IN_WEIGHT1,OUT_WEIGHT1,IN_WEIGHT2,OUT_WEIGHT2,IN
_WEIGHT3,OUT_WEIGHT3,IN_WEIGHT4,OUT_WEIGHT4

NULL,NUMERIC,CHARACTER,CHARACTER,CHARACTER,CHARACTER
,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,C
HARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHA
RACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARA
CTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACT
ER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER
,CHARACTER,CHARACTER,NUMERIC,CHARACTER,CHARACTER,CHA
RACTER,CHARACTER,CHARACTER,CHARACTER,CHARACTER,CHARA
CTER,NUMERIC,NUMERIC,NUMERIC,NUMERIC,NUMERIC,NUMERIC,
NUMERIC,NUMERIC

Clear Log File: The log and alarms file is erased every time an
operator logs out.

Scale View
You can view a list of transactions processed on a specific scale.
From the Tools menu select Scale View to display the form shown
below. Use the combo box to select a scale to retrieve information
from. You can limit a search by entering a minimum weight and a
starting date. Then click the Query button. The results of the search
will appear in the table at the bottom of the form.
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Host
This Tools menu option can be used to configure the data sent
from the WinBridge PC. The Host configuration form is shown
below. You can enable host communication, define the data you
want to send, define when it should be sent, and define where to
send it.
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Help Menu
The Help menu on the Vehicle Processing screen provides access
to a WinBridge on-line help file.

Software Version
Identifier

To find out which version of WinBridge you are using, select About
WinBridge from the Help menu and look in the Software Version
Identifier field.

Software
Checksum
Control

A checksum routine is run every time WinBridge is started (read
from the scale indicator). It checks that the legally relevant parts of
the software have not been modified. The checksum number is
shown on the About WinBridge screen. If a number is visible in the
Checksum Number field, it means that the original software parts
are being used. If, instead of a number, the message “This release
is not certified” appears, then one or more of the legally relevant
parts of the software has been modified.
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8 WinBridge Unattended Module

Introduction
The WinBridge Unattended Module is an add-on software program
that enables WinBridge to process weighing transactions in
unattended mode. An operator is not needed to process unattended
transactions. Instead, the driver of a vehicle can enter all the data
needed on an unattended driver station located at the scale. A driver
station with optional accessories is shown below.

To start unattended mode, click the unattended push button on the
Vehicle Processing screen’s toolbar.

Display

Proximity
Card

Reader

Slot Reader

Keypad

Printer

Display
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Data Entry
When unattended mode is enabled, the Badge and Short Code
menu items are activated in the Vehicle Processing screen’s Table
menu. Clicking on either of these will display four submenu items:
Vehicle, Contract, Account, and Product. You can assign a badge ID
or short code for each vehicle, contract, account, and product that
will be processed at the unattended weighing station. Drivers will
use the badge ID or short code to identify themselves at the driver
station.

Badge
A driver can use a badge to identify a vehicle, contract, account, or
product at the driver station. To assign a badge ID, select one of the
items from the Badge submenu. The Badge Administration form for
vehicles is shown below:

1. Enter an ID in the Badge ID data field.

2. Use the combo box to select the vehicle that you want to link to
the badge ID.

3. Click the Insert button to save this entry in the database.

The other three Badge Administration forms work the same way.
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Short Code
A short code is an ID number that the driver can type on the driver
station’s keypad to identify a vehicle, contract, account, or product.
To assign a short code, select one of the items from the Short Code
submenu. The Short Code Administration form for vehicles is shown
below:

1. Enter an ID in the Short Code data field.

2. Use the combo box to select the vehicle that you want to link to
the short code.

3. Click the Insert button to save this entry in the database.

The other three Short Code Administration forms work the same way.
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Unattended
Mode
Processing

1. When a vehicle arrives at the unattended scale, the driver must
enter the first input data (Contract or Vehicle ID) at the driver
station by using a badge or typing a short code.

2. The driver station then prompts the driver to enter any
additional data required for the transaction (required entries are
configured by your supplier). The driver can enter the data by
using the keypad or by scrolling through a list of options on the
driver station display (options are displayed one at a time).

The driver station keypad has numeric keys (0-9), plus
the following keys:

+ Scroll up the list of values displayed

– Scroll down the list of values displayed

C Clear the data that was typed in

F Abort transaction

E Enter the displayed data

•••• Press this key and then the E key to print a ticket

If data must be entered by an operator, the driver station
displays a wait message until the operator finishes
entering the data.

3. If the system’s confirmation function is enabled, the driver can
make changes to the input data during the first weighing. The
driver does this by scrolling through the data that have been
entered and using the E key to make changes. During the
second weighing, the driver cannot change any values that
have been entered.

4. Once all data have been entered correctly, the vehicle is
weighed automatically and, if the driver station is equipped
with a printer, it will print a ticket. The driver station will display
a message telling the driver whether the transaction was
accepted or refused. The driver can then take the ticket and
leave the unattended station. There is a timeout of ten seconds
before WinBridge will accept a new transaction.

If the WinBridge system shuts down accidentally in unattended
mode, it will automatically restart in unattended mode. To allow
automatic startup without an operator present, the PC system on
which WinBridge is installed must be set so that Windows starts
automatically and WinBridge runs automatically at startup.
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9 WinBridge Report Module

Creating a
Report

The WinBridge Report Module is an add-on software program that
lets you create or customize reports and tickets. There are two steps
to creating a report: (1) defining a query and (2) defining a layout.

•  Query: A query is a request for information from the WinBridge
database. When you define a query, you tell the database
which information (data fields) to include in the report. A query
consists of SQL statements.

•  Layout: The layout is how the data is arranged on the report.

To create a report, select WB Report from the Report/Ticket menu on
the Vehicle Processing screen. This displays the REPORT – Query
and Layout Definition form.

For a new report, assign a report ID, fill in the other data fields, and
set the radio buttons and check boxes. Then define a query and
layout for the report.
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Required Fields
Report ID: The identifier for the report.

Level: The security level assigned to the report (0-9).
This corresponds to the security level assigned to
each operator.

Layout: The layout created for the report (*.qrp).

Var List: Type of variable (date/time, string, number).

Item List: The variable data items included in the report.

NOTE: The Var List and Item List fields will be filled in when you
define a query for the report. If you edit an existing query, you will
need to change the list fields manually. Each of these two fields can
hold a maximum of 1,024 characters.

Optional Fields
Description: A description of the report.

Printer: Type in the name of the printer to be used or click
on the push button to the right of the field and
select from a list of available printers.

File: The file associated with the report.

Type: Use the radio buttons to indicate whether you
want to create a Report or a Ticket. A report
contains general information from the database’s
tables. A ticket contains information about the
current transaction (net weight, vehicle, etc.).

Destination: Select View to display the report or ticket on a
computer screen, Printer to print a copy on
paper, or File to output it to a file.

Company: Check the boxes to select which company
information you want to include in the report.
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Defining a
Query

You can create a new query or edit an existing query. The following
push buttons are used for defining queries:

This button displays the Edit Query form so that you can create a
new query from scratch or retrieve an existing query and modify it to
create a new query. This procedure is described in the “Editing a
Query” section of this chapter.

This button begins the Quick Query procedure, which is
recommended for creating a new report. If you click this button and
there is already a report with the report ID that you entered, it will be
replaced by the new Quick Query. Clicking the Quick Q. button
displays the form shown below.

Use the combo box at the top of the form to choose the WinBridge
table from which you want to select data fields. The data fields
available from the table are shown in the list box on the left.
Highlight each field that you want to include in the report, and use
the > arrow button to move it to the list box on the right.
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The arrow buttons are used to move items between the two list
boxes:

Moves an item from the left list box to the right list box. You can
also double-click on an item to move it.

Moves an item from the right list box to the left list box. You can
also double-click on an item to move it.

Moves all the items from the left list box to the right list box.

Moves all the items from the right list box to the left list box.

You can select fields from more than one table. Once you have
selected the fields that you want from one table, simply use the
combo box to highlight another table. Then select the desired fields
from it. In the example shown below, Account ID, Phone, and Fax
have been selected from the Account table. Contract ID and
Description have been selected from the Contract table.

When all the data fields that you want to include in the report are
displayed in the right list box, click the OK button to confirm the
choices you have made.
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If you have selected data fields from more than one table, the Link
Tables form will appear when you click OK.

This form lets you create a link between the tables. Select the item
on the left and the item on the right that you want to link. Then select
the type of link from the list box at the center of the form. The
following choices are available:

< = Less than or equal

< > Not equal

= Equal

> Greater than

> = Greater than or equal

LIKE Similar

When you have selected two items to be linked and the type of link,
click the Add button. After adding all links, click the OK button.

NOTE: The Search button is used to find related items from two
tables. For example, if you select the Transaction table and highlight
the Account ID field and then select the Account table, clicking the
Search button will highlight the Account table’s Account ID field.
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The following Edit Query form shows the query that was defined in
the Quick Query and Link Table forms above.

•  The Select statement lists the data fields that are to be included
in the report.

•  The From statement lists the tables that the data fields are from.

•  The Where statement lists the links between the tables.

Click the Test push button to test the syntax of the query. If the
syntax is correct, click the OK button.

NOTE: You must test a query every time that you create or edit it.
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Editing a Query
After you have defined a query with the Quick Query procedure, you
will need to edit it manually if you want to make changes. To edit an
existing query, open the REPORT – Query and Layout Definition form,
enter the Report ID in the appropriate data field, and then click the
Query button on the toolbar.

If you do not know the Report ID, click the Query button on the
toolbar to display the first report in the database. Then click the
Table button to display a table containing all existing reports.
Double-click the report that you want to edit.

1. With the query displayed on the REPORT – Query and Layout
Definition form, click the Query button in the lower right-hand
corner of the form. This will display the query on the Edit Query
form shown below.
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2. To add a field (for example, ACCOUNT.NAME) to the query
shown above, position the cursor at the end of the last line in
the Select statement (after CONTRACT.DESCRIPTION). Type a
comma, press the RETURN key, and enter the name of the field
you want to add on the next line. The query should now look
like this:

SELECT ALL
ACCOUNT.ACCOUNT_ID,
ACCOUNT.PHONE,
ACCOUNT.FAX,
CONTRACT.CONTRACT_ID,
CONTRACT.DESCRIPTION,
ACCOUNT.NAME

FROM ACCOUNT,
CONTRACT

WHERE ACCOUNT.ACCOUNT_ID = CONTRACT.ACCOUNT_ID

3. Click the Test button to test the revised query, and then click the
OK button.

4. Position the cursor at the end of the Var List field on the
REPORT – Query and Layout Definition form. Add a comma,
and type the variable for the item that you added to the query.
The variable type can be S for string, N for number, and D for
date/time (for example, S[5] means that you are adding a
string field and that is the fifth string field in the query). Since
ACCOUNT.NAME is a string, change the Var List as shown:

change S[0],S[1],S[2],S[3],S[4]

to S[0],S[1],S[2],S[3],S[4],S[5]

5. Position the cursor at the end of the Item List field. Add a
comma, and type the field name (ACCOUNT.NAME).

NOTE: You can use the END key to move the cursor to the end of the
Var List or Item List field.

6. Click the Layout button to display the report layout.



Chapter 9: WinBridge Report Module
Defining a Query

(9/00)   9-9

7. Open the Format menu on the menu bar and select Input and
then Input Items. The name of the new field should appear at
the end of the list of Input Names. Specify the Data Type
(String, Number, or Date/Time), and then click OK.

8. The new field should appear on the layout (you will need to
use the scroll bars to view the entire layout). You can use the
field tool from the tool palette to add a field to the layout. Then
click the down arrow to open the Content list box and select an
item to place in the field.

9. Now you can test the report to make sure it is correct.

NOTE: When you modify a report, you must also modify its layout.
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Reports with
Dynamic
Variables

When you edit a query, you can add dynamic variables (a WHERE
statement with variables). You can define as many as 12 dynamic
variables. The names of the variables must satisfy the following
syntactic rules:

String variables :sN

Numeric variables :nN

Date/Time variables :dN

N represents a number from 1 to 9.

Adding Dynamic Variables

1. In the Edit Query form, add the word AND at the end of the last
line of the WHERE statement, and then press the RETURN key.

2. Type the table name, a period, and then the field name.

3. Type one of the relations (=, !=, >, !>, <, !<, >=, or <=).

4. Then type the name of the variable (for example, :s1).

5. Repeat steps 1 to 4 for each variable you want to add.

When you click Test for a query with variables, WinBridge prompts
you to insert the description for the variables by showing an
appropriate window (for example, you can enter IDENTIFIER for a
string variable). After you have inserted the description, click OK.
Then click OK again to exit from the Edit Query form. Once you have
closed the Edit Query form, you must update the database with the
modified report. You can do that by clicking the Update push button
on the REPORT – Query and Layout Definition form.

To view the report produced by the dynamic query, click the Report
push button. Select the report from the window that is displayed.
After you select it, WinBridge will prompt you to insert the values for
the input variables in the dynamic query (For example, if you
included an in date and out date in the query, you will be asked to
enter the specific dates you want to use). Click OK to confirm the
values. If you do not specify any value for a dynamic variable when
you run a report, no filtering will be used based on that variable.
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Defining a
Layout

The layout is the second step in creating a report. To define a layout,
click the Layout push button on the REPORT – Query and Layout
Definition form.

The Layout button opens ReportWindows so that you can create a
new layout or modify an existing layout. Refer to the SQLWindows
ReportWindows User’s Guide for instructions about how to use
ReportWindows. The resulting layout is the same as that obtained
by clicking the Quick L. button when you create a new query.

The Quick L. (Quick Layout) button opens ReportWindows and
creates a default layout that corresponds to the current query. We
recommend using this button when you first create a new query. If
you do a quick layout on an existing layout, it will be overwritten.

You can insert variables (for data from the Company table) in a
report. Instructions for inserting variables are available in the
ReportWindows User’s Guide.

You can use data fields from the Company table without including
them in the query. From the layout, open the Format menu, select
Input and Variables, and then type in the following names:

sCld Company ID

sCName Company name

sCAddr1 Address 1

sCAddr2 Address 2

sCCity City

sCState State

sCZip Postal code

sCCountry Country

sCPhone Phone number

sCFax Fax number

sCFCode Tax number

All variables are string type.

You can then define and place the data fields in the report layout
and save it.

To be able to see the variables in a report’s layout, you must
activate them by checking the boxes in the Company section of the
REPORT – Query and Layout Definition form.

When you create reports with dynamic conditions, you must insert
the variables in the layout. Open the Format menu and select Input
and Variables, and then add the names of the variables and the
necessary data fields.
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The final two buttons on the REPORT – Query and Layout Definition
form are the Report and Test buttons.

Clicking the Report button displays the same form that appears
when you select Print Report from the Report/Ticket menu.

Clicking the Test button checks to make sure the query and layout
are syntactically compatible. If they are compatible, a blank ticket
will appear; if not, an error message will appear.
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Using Empty
Fields in a
Report

If one or more fields present in the query was not filled in on the
current transaction, the ticket printout will be blank. For example:
you want the Carrier Name printed on the ticket, but no carrier was
defined for the vehicle used in the current transaction. When the
query searches for the Carrier Name and finds nothing, the whole
query is left empty. This is true for all the fields in the database
except the following ones:

Vehicle ID: Since the vehicle can be transient (not present in the
database), you can define a so-called “outer join.” To do that you
have to add ( + ) to the WHERE statement of the query:
TRANSACTION.VEHICLE_ID = VEHICLE.VEHICLE_ID ( + ). If you do
that, the ticket will be printed even when the Vehicle ID is blank.

Container ID: When the container description is required on a ticket,
the ticket printout will be blank if a non-container vehicle is selected.
In order to avoid printing a blank ticket, insert a record with three
asterisks (***) as the Container ID in the Container table. This
record will automatically be used when the Container field is blank.

Contract ID: In the Contract table, insert a record with a plus sign
(+) as the Contract ID. This record will automatically be used when
the Contract field is blank.

Contract ID, Customer ID, Ship Addr ID, Product ID: If one of these
items is entered in second weighing, at the moment the inbound
ticket is being printed, the ticket will be blank. In order to avoid
printing a blank ticket, insert a record with an asterisk (*) as the ID
in each of the above tables. This record will automatically be used
when the ID field is blank.

It is not possible to apply the above conditions to any other field in
the database. Every other field in the database must filled in at the
time of the printout.
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Printing Gross,
Net, and Tare
Calculations

In order to have the Gross, Net, and Tare print on tickets rather than
simply inbound/outbound weights, place the following formulas on
the layout of the ticket.

On the Layout screen, select the field that you would like to represent
the Gross and type in the following formula:

NumberIFF((TRANSACTION.IN_WEIGHT –
TRANSACTION.OUT_WEIGHT), TRANSACTION.OUT_WEIGHT, 0,
TRANSACTION.IN_WEIGHT)

On the Layout screen, select the field that you would like to represent
the Tare and type in the following formula:

NumberIFF((TRANSACTION.IN_WEIGHT –
TRANSACTION.OUT_WEIGHT), TRANSACTION.IN_WEIGHT, 0,
TRANSACTION.OUT_WEIGHT)

For the Net calculation, type the following:

TRANSACTION.NET_WEIGHT
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Using Spare
Fields for
Calculations

To use a spare field from the configuration screen for calculations on
reports or tickets, follow the guidelines below. For this example, we
are using a Spare1 field to make further pricing calculations in
conjunction with the existing price fields. The first thing you need to
do is to name the Spare1 field as a numerical string.

1. On the REPORT – Query and Layout Definition form, press the
Query button in the lower right-hand corner of the form.
Position the cursor at the end of the last line of the SELECT
ALL statement, type a comma, and then type
@VALUE(TRANSACTION.SPARE1)AS P1. The P1 can be any
name that notifies you what the name of the field is.

2. Click Test and then OK.

3. Return to the REPORT – Query and Layout Definition form and
place the cursor at the end of the Var List field. Type N[#],
which is a numerical variable. Be sure to use the next
consecutive number in place of the # sign.

4. Then place the cursor at the end of the Item List. Type in the
P1 or whatever name you gave this variable in the query.

NOTE: The variable must be placed at the same position in the
Variable List and Item List.

5. Once you have completed these steps, go to the Layout
screen and select Format and then Input Items.

6. Type the name of the variable (for example, P1) and select
New.

7. Click Close.

8. Use the field tool to place a new field on your ticket/report.

9. Select this new field and click the Editor button. Then select
the name of the variable (for example, P1).

10. Now you are able to provide other fields that can use this
variable in calculations because the system understands it as
a numerical variable.
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Printing
Duplicate
Tickets

In order to print duplicate tickets, you will need to include the
variable sDuplicate on the ticket. This places the word duplicate on
all duplicate tickets that are printed. A duplicate ticket will not print
unless this variable is on the ticket to satisfy Weights & Measures
requirements and protect against fraud. To place this variable on the
ticket, go to Format, Input Items, type sDuplicate, select New, and
then click OK.

Once you have placed this as an input item, you can create a field
using the field tool. Then with the field selected, click the Editor
button. Select the sDuplicate variable from the list and then click OK.
Now you will be able to print this ticket as a duplicate ticket from the
Vehicle Processing screen.
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Using Dates
in Reports

The following example can be used to insert an MM/DD/YY date
format in a comma delimited report.

‘,’ || Str Mid (Str Pad (Date to Str (outdate), 7), 5, 2) ||

Str Mid (Str Pad (Date to Str (outdate), 10), 8, 2) ||

Str Mid (Str Pad (Date to Str (outdate), 4), 2, 2) || ‘,’

|| is a concatenation character (Shift+F7 x 2)

MM

YYYY/MM/DD – 06.22.45.000000

YYYY/MM

YYYY/MM/DD – 06.22.45.000000

YYYY/MM/DD

DD

YYYY/MM/DD – 06.22.45.000000

YYYY

YY
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10 Report Writer Tutorial

Generating a
Ticket

Open the WinBridge REPORT – Query and Layout Definition form by
selecting WB Report from the Report/Ticket menu on the Vehicle
Processing screen. Enter the following information in the data fields:

Report ID: TESTT
Level: 0
Description: Test Ticket
Printer: (Press the Printer button and select from the list)
File: (Leave blank)
Layout: TESTT.QRP
Var List: (Leave blank)
Item List: (Leave blank)

Type: Select the Ticket radio button
Destination: Select the View radio button
Company: Check the Id and Name boxes

Your screen should look like the one shown below:
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Defining the
Query

A query provides the Report Writer with all of the information about
a transaction that is used to print a ticket. Since a ticket is produced
for each transaction, the Transaction table is the main source of
information used to generate tickets.

1. To begin a query, click the Quick Q. button on the form that
you just filled in. The Quick Query form will appear. You
should use this button only when you first create a query
because it will write over any existing query.

2. Select Transaction from the combo box at the top of the form.
The list box on the left displays the transaction data that is
available. The list box on the right displays the data to be
included in the report.

3. Select the following transaction data items from the list box on
the left and move them to the list box on the right:

Account ID
Product ID
Vehicle ID
In Weight
Out Weight
Net Weight
In DateTime
Out DateTime



Chapter 10: Report Writer Tutorial
Generating a Ticket

(9/00)   10-3

Out Consecutive
Wt Unit

To move an item to the box on the right, highlight it and click
the > arrow button.

4. Change the combo box to Account and select Name.

5. Change the combo box to Product and select Description.

6. Change the combo box to Vehicle and select Description.

7. When the form looks like the one shown below, click OK.

Since your query includes items from several tables (the
Transaction, Account, Product, and Vehicle tables), you will need to
link those tables.
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Linking Tables
Report Writer searches the Transaction table for information about a
specific transaction that you want to include on a ticket. By linking
other tables to the Transaction table, you make it possible to include
information from those tables. For example, you can link the
Account ID field in the Transaction table to the Account ID field in
the Account table. When Report Writer prints a ticket, it will then be
able to include information about the account that was involved in
the transaction.

Because you have included several tables in your quick query, the
Link Tables form will appear when you click the OK button.

1. Select Transaction in the left combo box, and highlight Account
ID in the list box below it.

2. Select = in the center combo box.

3. Select Account in the right combo box, and highlight Account
ID in the list box below it.

4. Click the Add button to create a link.

5. Select Transaction in the left combo box, and highlight Product
ID in the list box below it.
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6. Select = in the center combo box.

7. Select Product in the right combo box, and highlight Product
ID in the list box below it.

8. Click the Add button to create a link.

9. Select Transaction in the left combo box, and highlight Vehicle
ID in the list box below it.

10. Select = in the center combo box.

11. Select Vehicle in the right combo box, and highlight Vehicle ID
in the list box below it.

12. Click the Add button to create a link.

13. The three links that you just created will be shown in the list
box at the bottom of the form. Click the OK button to accept the
links.
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You will now return to the REPORT – Query and Layout Definition
form. The Var List (variable list) and Item List fields should now
contain the information that you just entered. The variable list
identifies the type of variable (Date/Time, String, Number), and the
item list identifies the specific type of variable. When you use the
Query button to change the query, the change will be reflected in the
variable list and item list (always in the proper order).
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Test the Query
Once you have completed the query and linked the tables, press the
Query button in the lower right-hand corner of the REPORT – Query
and Layout Definition form. This will display the query on the Edit
Query form.

All elements to be printed on your report or ticket should show up in
the display area. From this form, you can also use SQL statements
to refine your query. Click the Test button to test the query or any
changes that you make, and then click OK to confirm the query.
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Defining the
Layout

To generate a basic report, which can be modified to print a ticket,
click the Quick L. button on the REPORT – Query and Layout
Definition form. This will open a ReportWindows form that shows all
of the items defined in your query, plus the text objects that are used
as column headings.

Sections of a Report/Ticket:

•  Report Header appears at the beginning of the report.

•  Page Header appears at the top of each page.

•  Detail Block is the body of the Ticket/Report.

•  Page Footer appears at the bottom of each page.

•  Report Footer appears at the end of the report.

If you add a break group (a subsection) to the report, you can also
insert a Break Group Header and Break Group Footer.

Tool Palette
Open the View menu on the ReportWindows menu bar, and select
Palette from the drop-down menu to display the tool palette.

Use the right mouse button to scroll through the tools, or point at a
tool and use the left mouse button to select it. You can also select a
tool from the Tool menu on the menu bar. The tool palette is shown
to the left. The tools (from left to right, starting with the top row) are
described below:

•  Selector Tool - For selecting objects.

•  Background Text Tool - For adding background text.

•  Field Tool - For adding text fields.

•  Box Tool – For adding boxes.

•  Picture Tool - For adding picture objects.

•  Line Tool - For adding line objects (complete work areas).

•  Graph Tool - For adding graphs.

•  Crosstab Tool - For adding tables.

•  Auto Selector Off - Pointer remains on last item used.

•  Auto Selector On - Pointer returns to selector tool.

The ReportWindows layout form for the query that you created is
shown below, with the tool palette displayed. Note that
TRANSACTION.VEHICLE_ID appears twice: once as a background
text object (a column heading for a report) and once as a field
object (an entry under the column heading) This is the same for
each item specified in the query.
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Delete an Object
1. Use the selector tool to highlight the TRANSACTION.VEHICLE_ID

background text object (which is shown in the Page Header
section).

2. Open the Edit menu on the menu bar and select Cut.

3. The object should be deleted.

Delete a Line
1. Use the selector tool to highlight the blank line just below Page

Header.

2. Select Cut from the Edit menu.

3. The line object should be deleted.

4. Delete all of the lines from the page header.

Add Lines to the Page Header
1. Select the line tool.

2. Place the cursor on the Page Header heading.

3. Click the left mouse button until there are five lines under Page
Header.

4. The screen should look like the one shown below.
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Add Lines to the Detail Block
1. Select the line tool.

2. Position the cursor directly on the Detail Block heading.

3. Click the left mouse button until you have added seven lines.

Add a Picture to the Ticket
1. Select the picture tool.

2. Position the cursor at the left edge of the first blank line in the
page header area. Hold down the left mouse button and drag
the cursor to draw a box 1.5 inches wide and 5 lines deep.
Release the mouse button. To position the cursor and measure
the width of the box, use the ruler at the top of the window or
use the Position and Width fields above the ruler.

3. When the box is complete, open the Edit menu and select
Paste From.

4. Select a bitmap (*.bmp) from the list of available files.

5. Click OK.

6. The picture should be placed in your ticket.
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Add a Second Picture to the Ticket
1. Select the picture tool again.

2. Position the cursor 4 inches from the left edge of the first blank
line in the page header area, and create another box 1.5
inches wide by 5 lines deep.

3. Open the Edit menu and select Paste From.

4. Select another bitmap (*.bmp) file.

5. Click OK.

6. The second picture should be placed in your ticket.

Add Text to the Page Header
1. Select the background text tool.

2. Place the cursor on the first line in the page header, just to the
right of the first picture that you inserted. Click the left mouse
button, and type the text “Mettler-Toledo Inc.” The complete text
is displayed in the Content data field at the top of the window.

3. Choose the selector tool.

4. Highlight the text that you just entered.

5. Choose a font and a point size (14) from the combo boxes to
the right of the Width combo box.

6. Use the same procedure to fill in the address lines of the page
header, so that your screen looks like the one shown below.
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Add the Date to the Last Line of the Page Header
1. Select the field tool.

2. Position the cursor in the last line of the page header, midway
between the two pictures. Click the left mouse button to create
a field for the date.

3. Click the Editor button to display the Formula Editor screen.

4. Double-click on the CurrentDate function shown in the right-
hand window. The CurrentDate function will move to the top
window.

5. Click OK. The CurrentDate function will be placed in the field
you created.

6. Click on the scroll arrow to the right of the Fmt field.

7. Choose the Date format you want for your ticket.

Your page header is now complete.
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Detail Block
Use the selector tool to move the input objects in the Detail Block to
form a pattern like the one shown below.

•  To move an object, position the cursor on the object. Hold
down the left mouse button to highlight the object, and drag it
to the new location.

•  To duplicate the Weight Unit field, use the Copy and Paste
commands in the Edit menu.

•  Use the line tool to add lines if necessary.

•  Use the background text tool to create any headings that you
want to be printed with the input objects.

Preview Your Ticket
To preview your ticket layout, open the Report menu and select
Preview. To return to the layout design form, open the Report menu
and select Design.

Save and Exit
Open the File menu and select Save to save your layout. Open the
File menu and select Exit to return to the REPORT – Query and
Layout Definition form.
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Generating a
Report

Open the WinBridge REPORT – Query and Layout Definition form by
selecting WB Report from the Report/Ticket menu on the Vehicle
Processing screen. Enter the following information in the data fields:

Name: TESTREP
Level: 0
Description: Test Report
Printer: (Press the Printer button and select from the list)
File: (Leave blank)
Layout: TESTREP.QRP
Var List: (Leave blank)
Item List: (Leave blank)
Type: Select the Ticket radio button
Destination: Select the View radio button

1. Click the Quick Q. button to display the Quick Query form.

2. Select Transaction from the combo box at the top of the form.

3. Select the following transaction database items from the list
box on the left and use the arrow buttons to move them to the
list box on the right:

Account ID
In DateTime
Out DateTime
Net Weight
Vehicle ID
Wt Unit

4. When finished, click OK to return to the REPORT – Query and
Layout Definition form. You can click the Query button in the
lower right-hand corner of the screen to display the Edit Query
form.
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Dynamic
Variables

Dynamic variables are used to modify a report before you run it. For
example, you can use Date variables to provide details about
transactions that were made between two dates.

Dynamic Variables Available:

Date :d1 to :d12

String :s1 to :s12

Number :n1 to :n12

The items that you selected during your quick query should appear
on the Edit Query form shown below:

SELECT ALL

TRANSACTION.ACCOUNT_ID,

TRANSACTION.IN_DATETIME,

TRANSACTION.OUT_DATETIME,

TRANSACTION.NET_WEIGHT,

TRANSACTION.VEHICLE_ID,

TRANSACTION.WT_UNIT

FROM TRANSACTION

Refine your query to include two dynamic date variables. Position
the cursor at the end of the FROM TRANSACTION line and press the
RETURN key to move the cursor to the next line. Enter the following
WHERE clauses connected by the word AND:

WHERE    TRANSACTION.IN_DATETIME>=:d1 AND

  TRANSACTION.OUT_DATETIME<=:d2
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Order By
ORDER BY is an SQL statement that sorts or indexes the items
presented in the report. The order of the data is especially important
when break group reports are to be generated. Reports with break
groups in them group all transactions of a certain type (for
example, all transactions belonging to Account 1).

Refine your query further by adding an ORDER BY statement.

SELECT ALL

TRANSACTION.ACCOUNT_ID,
TRANSACTION.IN_DATETIME,
TRANSACTION.OUT_DATETIME,
TRANSACTION.NET_WEIGHT,
TRANSACTION.VEHICLE_ID,
TRANSACTION.WT_UNIT

FROM TRANSACTION
WHERE      TRANSACTION.IN_DATETIME>=:d1 AND

    TRANSACTION.OUT_DATETIME<=:d2
ORDER BY TRANSACTION.ACCOUNT_ID

If you are using more than one ORDER BY element, each element
should be separated by a comma.

Your final query should appear as shown below:
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Click the Test button, and enter the prompts for your dynamic
variables, as shown in the Dynamic Conditions form below. Click
OK when you are finished, and then click OK again to exit the Edit
Query screen.
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Formatting
Formatting a report layout is similar to formatting a ticket layout.

Use Quick Layout to Format Your Report
1. Click the Quick L. button on the REPORT – Query and Layout

Definition form.

2. Add a title to your report in the report header. Use the line tool
to add a line to the report header. Then use the background
text tool to position and enter text for the title in the new line.

3. Use the background text tool to add column headings.
Headings can be placed in the report header or page header.

4. Arrange the field objects to allow enough space for the required
Information.

5. Use preview mode to check your changes. Open the Report
menu and select Preview. When you want to return to design
mode, open the Report menu and select Design.

Create a Break Group
1. Open the Format menu and select Break Groups to display the

Format Break Groups form.

2. Input items are shown in the window on the left. Choose
TRANSACTION.ACCOUNT_ID as your first break group. Use the
arrow button to move it to the Break Groups window on the
right.

3. When you click OK, a new break group header and break
group footer will be added to the report.

NOTE: due to space limitations, only part of the full title might
be displayed (Header:...CTION.ACT_ID).

Create a Field in the Break Group Footer
1. Use the line tool to add a line to the Footer:

TRANSACTION.ACCOUNT_ID.

2. Use the field tool to add a field under the Net Weight column.

3. Click the Editor button to display the Formula Editor form.

4. Double-click on Sum in the Functions list box.

5. Double-click on TRANSACTION.NET_WEIGHT in the Data Items
list box.

6. Click OK to create a formula that reads
SUM(TRANSACTION.NET_WEIGHT).

Create a Field in the Page Footer
1. Use the field tool to add a field under the Net Weight column.

2. Click the Editor button to display the Formula Editor form.

3. Double-click on Reportsum in the Functions list box.

4. Double-click on TRANSACTION.NET_WEIGHT in the Data Items
list box.
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5. Click OK to create a formula that reads
REPORTSUM(TRANSACTION.NET_WEIGHT).

6. Your form should look like the one shown below:

Save Your Report Format
Open the File menu and select Save.

Exit ReportWindows
Open the File menu and select Exit. You will return to the REPORT –
Query and Layout Definition form.

View Your Report
Click the Report button to display the Reports form. Highlight the
report that you just created. Click the Print button to print the report,
the View button to view it on the computer screen, or the To File
button to output it to a file.

You will be asked to insert filter conditions (for example, the specific
dates that you want the report to cover), and then the report will run.
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11 Specific Industries

Forestry
We provide a WinBridge package specifically for the forestry
industry. It simplifies your job by giving you one tool designed to
keep track of everything you need to know about your transactions.
We have configured the standard WinBridge tables to store the
information that is important to your operation. When you install
the WinBridge forestry option, you will use the Vehicle Processing
screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Truck and Stratum fields.

Required Data Fields
Mill: Mill identifier

Truck: Truck identifier

Contractor: Contractor identifier
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Stratum: Wood stratum

Species: Wood species

Timbermark: Identifying mark stamped in the wood (Verified
and Date Check)

Trans. Type: Type of transaction: purchased wood, prescaled,
or transfer (Verified)

Butts Ahead: Percentage of wood with wide end toward front of
truck

Destination: Mill where wood is to be shipped

Quality: Quality of product

Remark: A remark that appears on screen

Optional Data Fields
Cut Block: Area (# or county) where wood came from

(Verified)

Log Sort: Size of logs: tree length, saw logs, 8 feet, mixed

Yard: Location in lumber yard where wood will be
delivered

Peeler %: Percentage of peeler logs

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each forestry table.

Forestry Table Standard WinBridge Table

Contractor Account

Species Carrier

Stratum Product

Quality Remark

Remark Remark2

Mill Company

Trans. Type Table 1

Cut Block Table 2

Butts Ahead Table 3

Deck or Yard Table 4

Destination Table 5

Log Sort Table 7

Peeler % Table 8

Timbermark Table 15



Chapter 11: Specific Industries
Forestry

(9/00) 11-3

Daily Weight Button
Click the Daily Wt. Push button on the Vehicle Processing screen to
find out how much of a product has been weighed during the
current day. A window will appear to display the daily weight for
the product that is selected in the Stratum data field.

Sampling
WinBridge lets your operators know when to sample a product.
You define how the sampling schedule is set up:

•  Step Sampling: A sample is taken when a preset number of
loads has been processed.

You can set up a schedule to take samples by individual stratum
or other factor. See Chapter 4 for information about sampling.

Timbermark Expiration
The Timbermark table stores information about timbermarks,
including a field for the timbermark’s expiration date. When a
transaction is processed for an expired timbermark, a message
appears on screen to notify the operator. The operator can click OK
to continue with the transaction. See Chapter 4 for information
about using expiration dates in the extended tables.

Forestry Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Contractor Report

•  Cut Block Report

•  Destination Report

•  Mill Report

•  Species Report

•  Stratum Report

•  Timbermark Report

•  Transaction Report
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Agriculture
We provide a WinBridge package specifically for the agriculture
industry. It simplifies your job by giving you one tool designed to
keep track of everything you need to know about your transactions.
We have configured the standard WinBridge tables to store the
information that is important to your operation. When you install
the WinBridge agriculture option, you will use the Vehicle
Processing screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields
Vehicle: Vehicle identifier

Carrier ID: Carrier identifier

Product: Product identifier

Account: Account identifier

Remark: A remark that appears on screen

Unloading Area: Unloading location (Verified)
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Silo Location: Silo identifier (Verified)

Product Grade: Product grade (Verified)

Quality: Product quality

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each agriculture table.

Agriculture Table Standard WinBridge Table

Quality Remark

Unloading Area Table 1

Silo Location Table 2

Product Grade Table 3

Daily Weight Button
Click the Daily Deliv. Wt. Push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Inventory
The WinBridge program can keep track of inventory levels by
automatically adjusting them each time a delivery is processed.

Sampling
WinBridge lets your operators know when to sample a product.
You define how the sampling schedule is set up:

•  Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

•  Random Sampling: A sample is taken at random within a
preset number of loads or weight range.

You can set up a schedule to take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Vehicle Tracking
Click the Trans push button to view a table listing all the vehicles
that are currently on your site.

Manual Weight Adjustment
The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subtracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.
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Presets
Presets are used to speed up transactions by reducing repetitive,
manual data entry. Suppose a vehicle always carries the same
product for the same customer. You can define presets that link the
vehicle to the customer and product. When you enter the vehicle ID
to process a transaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Agriculture Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Product Grade Report

•  Silo Location Report

•  Unload Area Report
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Aggregate:
Sand and
Gravel

We provide a WinBridge package specifically for the aggregate
(sand and gravel) industry. It simplifies your job by giving you one
tool designed to keep track of everything you need to know about
your transactions. We have configured the standard WinBridge
tables to store the information that is important to your operation.
When you install the WinBridge aggregate option, you will use the
Vehicle Processing screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, Customer, Delivery Zone, Delivery Method,
and Product Grade fields.

Required Data Fields
Contract: Contract identifier

Vehicle: Vehicle identifier

Carrier ID: Carrier identifier
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Product: Product identifier

Account: Account identifier

Delivery Zone: Delivery zone (Verified)

Delivery Method: Delivery method (Verified)

Product Grade: Product grade (Verified)

Optional Data Fields
Remark: A remark that appears on screen

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each aggregate table.

Aggregate Table Standard WinBridge Table

Delivery Zone Table 1

Delivery Method Table 2

Product Grade Table 3

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Inventory
The WinBridge program can keep track of inventory levels by
automatically adjusting them each time a delivery is processed.

Virtual Indicator
Your WinBridge system can read weights from up to four indicators
(four scales). Plus it provides a virtual indicator for processing
large vehicles that need to be weighed on more than one scale.
You can define the virtual indicator as the sum of two or more
existing indicators. See Chapter 4 for information about setting up
a virtual indicator.

Taxes and Surcharges
The WinBridge program can add taxes and surcharges when
processing transactions. You can define up to two taxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about taxes and Chapter 4 for information about surcharges.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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ODBC
The WinBridge database is ODBC compliant, allowing you to send
data from it to accounting and other software packages.

Aggregate Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Carrier Report

•  Delivery Method Report

•  Delivery Site Report

•  Delivery Zone Report

•  Product Grade Report
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Aggregate:
Concrete and
Asphalt

We provide a WinBridge package specifically for the aggregate
(concrete and asphalt) industry. It simplifies your job by giving you
one tool designed to keep track of everything you need to know
about your transactions. We have configured the standard
WinBridge tables to store the information that is important to your
operation. When you install the WinBridge aggregate option, you
will use the Vehicle Processing screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, Customer, Delivery Site, Batch ID, Product
Info, and Set Point fields.

Required Data Fields
Contract: Contract identifier

Vehicle: Vehicle identifier

Carrier ID: Carrier identifier
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Product: Product identifier

Account: Account identifier

Remark: A remark that appears on screen

Delivery Zone: Delivery site (Verified)

Batch ID: Batch identifier (Verified)

Product Info: Additional product information (Verified)

Set Point: Set point: set per contract (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each aggregate table.

Aggregate Table Standard WinBridge Table

Delivery Site Table 1

Batch ID Table 2

Product Info Table 3

Set Point Table 4

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Inventory
The WinBridge program can keep track of inventory levels by
automatically adjusting them each time a delivery is processed.

Virtual Indicator
Your WinBridge system can read weights from up to four indicators
(four scales). Plus it provides a virtual indicator for processing
large vehicles that need to be weighed on more than one scale.
You can define the virtual indicator as the sum of two or more
existing indicators. See Chapter 4 for information about setting up
a virtual indicator.

Taxes and Surcharges
The WinBridge program can add taxes and surcharges when
processing transactions. You can define up to two taxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about taxes and Chapter 4 for information about surcharges.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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ODBC
The WinBridge database is ODBC compliant, allowing you to send
data from it to accounting and other software packages.

Aggregate Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Carrier Report

•  Batch ID Report

•  Product Information Report
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Waste:
Recycling

We provide a WinBridge package specifically for the waste
recycling industry. It simplifies your job by giving you one tool
designed to keep track of everything you need to know about your
transactions. We have configured the standard WinBridge tables to
store the information that is important to your operation. When you
install the WinBridge waste option, you will use the Vehicle
Processing screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields
Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle

Carrier ID: Carrier identifier

Remark: A remark that appears on screen
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Product: Product identifier

Account: Account identifier

Unload Area: Unloading location (Verified)

Origin: Originating location (Verified)

Product Grade: Product grade (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table

Unloading Area Table 1

Origin Table 2

 Grade Table 3

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Sampling
WinBridge lets your operators know when to sample a product.
You define how the sampling schedule is set up:

•  Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

•  Random Sampling: A sample is taken at random within a
preset number of loads or weight range.

You can set up a schedule to take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Presets
Presets are used to speed up transactions by reducing repetitive,
manual data entry. Suppose a vehicle always carries the same
product for the same customer. You can define presets that link the
vehicle to the customer and product. When you enter the vehicle ID
to process a transaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Destination Report

•  Origin Report

•  Product Grade Report

•  Delivery Location Report

•  Unload Area Report
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Waste:
Transfer
Stations

We provide a WinBridge package specifically for the waste market.
It simplifies your job by giving you one tool designed to keep track
of everything you need to know about your transactions. We have
configured the standard WinBridge tables to store the information
that is important to your operation. When you install the WinBridge
waste option, you will use the Vehicle Processing screen shown
below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields
Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle

Carrier ID: Carrier identifier



Chapter 11: Specific Industries
Waste: Transfer Stations

(9/00) 11-17

Remark: A remark that appears on screen

Product: Product identifier

Account: Account identifier

Unload Area: Unloading location (Verified)

Destination: Shipment destination (Verified)

Origin: Originating location (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table

Unloading Area Table 1

Origin Table 2

Destination Table 3

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Sampling
WinBridge lets your operators know when to sample a product.
You define how the sampling schedule is set up:

•  Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

•  Random Sampling: A sample is taken at random within a
preset number of loads or weight range.

You can set up a schedule to take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Presets
Presets are used to speed up transactions by reducing repetitive,
manual data entry. Suppose a vehicle always carries the same
product for the same customer. You can define presets that link the
vehicle to the customer and product. When you enter the vehicle ID
to process a transaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Destination Report

•  Origin Report

•  Delivery Location Report

•  Unload Area Report
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Waste:
Landfills

We provide a WinBridge package specifically for landfill
operations. It simplifies your job by giving you one tool designed to
keep track of everything you need to know about your transactions.
We have configured the standard WinBridge tables to store the
information that is important to your operation. When you install
the WinBridge waste option, you will use the Vehicle Processing
screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields
Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle

Carrier ID: Carrier identifier

Remark: A remark that appears on screen
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Product: Product identifier

Account: Account identifier

Cell Location: Cell location (Verified)

Destination: Shipment destination (Verified)

Origin: Originating location (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table

Cell Location Table 1

Destination Table 2

Origin Table 3

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Taxes and Surcharges
The WinBridge program can add taxes and surcharges when
processing transactions. You can define up to two taxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about taxes and Chapter 4 for information about surcharges.

Manual Weight Adjustment (Scrap)
The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subtracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.

ODBC
The WinBridge database is ODBC compliant, allowing you to send
data from it to accounting and other software packages.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Destination Report

•  Origin Report

•  Cell Location Report
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Waste: MERF
and RRF

We provide a WinBridge package specifically for the waste (MERF
and RRF) industry. It simplifies your job by giving you one tool
designed to keep track of everything you need to know about your
transactions. We have configured the standard WinBridge tables to
store the information that is important to your operation. When you
install the WinBridge waste option, you will use the Vehicle
Processing screen shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields
Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle

Carrier ID: Carrier identifier

Remark: A remark that appears on screen

Product: Product identifier

Account: Account identifier
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Delivery Location: Delivery location within site (Verified)

Destination: Final shipping destination (Verified)

Origin: Originating location (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table

Delivery Location Table 1

Destination Table 2

Origin Table 3

Daily Weight Button
Click the Daily Weight push button on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Taxes and Surcharges
The WinBridge program can add taxes and surcharges when
processing transactions. You can define up to two taxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about taxes and Chapter 4 for information about surcharges.

Manual Weight Adjustment (Scrap)
The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subtracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.

Units of Measure
You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.

ODBC
The WinBridge database is ODBC compliant, allowing you to send
data from it to accounting and other software packages.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

•  Standard WinBridge Reports

•  Destination Report

•  Origin Report

•  Delivery Location Report

•  Unload Area Report
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WB-Standard
The WB-Standard option is a simplified version of the WinBridge
software package. It is designed for operations that do not have
complex processing or data management requirements. The
Vehicle Processing screen for this option is shown below:

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Customer, and Product fields.

Required Data Fields
Vehicle: Vehicle identifier

Account: Account identifier

Product: Product identifier

Remark: A remark that appears on screen

Remark2: A remark that appears on screen

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The following
tables are available with this version of the program:
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Vehicle table

Customer table

Product table

Remark table

Remark2 table

The following tables and functions are not available with the WB-
Standard option:

Contract table

Carrier table

Container table

Badge table (Unattended option)

Short Code table (Unattended option)

Groups table

Extended tables

Virtual Indicator

Scales 3 and 4

Host Communication

Networking

Reports

The WB-Standard program provides a selection of standard
reports. The Report Module can be added to the package to allow
you to create your own report and ticket formats.
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12 Definitions

Accelerator
A keyboard shortcut for choosing a menu item or activating a push
button (for example, ALT+Key, CTRL+Key, and SHIFT+Key).

Check Box
A box representing an option that can be turned on or off. The
option is turned on when a check mark appears in the box.

Combo Box
An object that displays a list of items when you click on the down
arrow. When you select an item from the list, it will be displayed in
the box. You can also display the list of items by pressing
ALT+DOWN ARROW and close it by pressing ALT+UP ARROW.

Data Field
A box where you can enter data or where a program displays data.
If a data field described in this manual does not appear on your
computer screen, your supplier can install it for you.

Disable
To turn off an option so that it cannot be selected. When a menu
item or push button is disabled, it appears dimmed or gray.

Enable
To turn on an option so that it can be selected.

Filter
Information used to help search for data. When a filter is included
in a query, the search is limited to records that match the filter.

Form
A window or box that lets you communicate with an application.
Most WinBridge forms contain data fields where you can enter or
view information.

Format
The way in which data is displayed on the screen. Special formats
are used to display currency, percentage, decimal, date, time, and
numbers.

Group Box
A box marked on a computer screen to identify a set of related
objects or data fields.
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Icon
A picture that represents an application or window that is closed or
minimized.

List Box
A box that displays a read-only list of items. You can scroll through
all the items in the list box by using the two vertical arrow keys or
by moving the scroll bar.

Menu
A list of options. You can open a menu by clicking the menu title in
the menu bar.

Menu Item
An option in a menu or menu bar. When you click on it, a menu
item will start an action or display another menu.

Primary Key
The data field used to identify records in a WinBridge table. For
example, the Product ID is the primary key for the Product table.
Each product listed in the table must have its own unique ID.

Push Button
An object that begins an action when you click on it.

Query
A request for information from a database. The request can include
a filter to limit the search to a specific type of data.

Radio Button
A circle representing an option that can be turned on or off. The
option is turned on when a dot appears in the circle. In a group of
radio buttons, only one button can be on.

Scroll Bar
A box with an arrow at each end and a slide bar in between. Scroll
bars are used when the contents of a window or list box are too
large to be displayed all at once. A window can have a vertical
scroll bar at the right side of the window and a horizontal scroll bar
at the bottom of the window.

Table
The basic data storage structure of the WinBridge database. A table
is a grid divided into columns and rows.

Window
A rectangular area on the computer screen where an application
receives input from the mouse or keyboard and displays output.
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